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Read through this operating manual carefully before use and become familiar with the product. 
Installation and start-up should not be carried out before reading and understanding this 
document. Keep this manual readily available so that you can reference it as needed. 
 

1.1  What Is the Purpose of this Operating Manual? 
This manual serves as an aid for the installation and operation of the product and supports the 
technical staff with all operating and maintenance tasks to be performed. Furthermore, this 
manual is aimed at preventing dangers to life and health of the user and third parties. 
 

1.2  Who Is this Operating Manual Targeted to? 
The operating manual provides a code of conduct for personnel tasked with the setup, 
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with 
respect to the operation of gas engines and basic knowledge of electronic ignition systems are 
necessary. Persons who are only authorized to operate the gas engine shall be trained by the 
operating company and shall be expressly instructed concerning potential hazards. 
 

1.3  Which Symbols Are Used in the Operating Manual? 
The following symbols are used in this manual and must be observed: 

 

Example 

This symbol indicates examples, which point out necessary handling steps 
and techniques. In addition, you receive additional information from the 
examples, which will increase your knowledge. 

   

 

Notice 

This symbol indicates important notices for the user. Follow these. In 
addition, this symbol is used for overviews that give you a summary of the 
necessary work steps. 

   

 

Warning 

This symbol indicates warnings for possible risks of property damage or 
risks to health. Read these warning notices carefully and take the 
mentioned precautionary measures. 

   

1 General Information 
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Danger 

This symbol indicates warnings for danger to life, especially due to high 
voltage. Read these warning notices carefully and take the mentioned 
precautionary measures. 

  
 

1.4  Which Abbreviations/Acronyms Are Used in the Operating Manual? 
In the manual or the user interface, the following abbreviations / acronyms are used. 

Abb. Term Description Explanation 

ADV Advance Advanced with 
respect to top dead 
center 

Indicates the direction for 
timing 

ASO Auxiliary 
Synchronization 
Output 

  Output for synchronizing the 
MIC3+ and other controllers 

ATDC After Top Dead 
Center 

    

BTDC Before Top Dead 
Center 

    

CAN bus Controller Area 
Network bus 

Bus for control 
devices/networks 

Asynchronous serial 
connection system for 
linking control units 

CE Conformité 
Européenne 

Conformity with EU 
directives 

Mark based on EU 
legislation for certain 
products in conjunction with 
product safety 

CPU Central Processing 
Unit 

    

°crankshaft Degree crankshaft   Unit for the rotation angle of 
the crankshaft 

CSA Canadian Standards 
Association 

  Organization that defines 
standards, inspects 
products for safety 
compliance, and issues 
pertinent certifications. 
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Abb. Term Description Explanation 

DC Direct Current     

DetCon Detonation Control 
System 

  Serves to prevent major 
engine damage that can be 
caused by knocking 
combustion. 

EMI Electromagnetic 
Interference 

    

EMC Electromagnetic 
Compatibility 

  Compatibility of electrical or 
electronic equipment items 
with their surroundings 

GPI General Purpose 
Input 

Multi-purpose input   

GPO General Purpose 
Output 

Multi-purpose 
output 

  

HV High Voltage     

ISO International 
Organization for 
Standardization 

    

LED Light Emitting Diode   Light emitting electronic 
semiconductor 

MIC MOTORTECH Ignition 
Controller 

    

MICT MOTORTECH 
Integrated 
Configuration Tool 

  Software for the 
configuration of the MIC3+ 

MOSFET Metal Oxide 
Semiconductor Field-
Effect Transistor 

  Semiconductor component 

PG Panzergewinde Panzer screw thread Screw thread type for cable 
screw connections 

POT Potentiometer   Continuously adjustable 
potential divider 

PWR Power Output/current   

RET Retard Retarded with 
respect to the top 
dead center 

Indicates the direction for 
timing 



1 General Information 
 

10 Rev. 07/2021 

Abb. Term Description Explanation 

RS485/ 
TIA485 

Recommended 
Standard 485/ 
Telecommunications 
Industry Association 
485 

  Industrial standard for a 
physical interface for 
asynchronous serial data 
transfer 

TDC Top Dead Center     

USB Universal Serial Bus   Serial connection system to 
link a computer to external 
devices 
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2.1  General Safety Instructions 
The following safety instructions must be followed in the area in which the device is operated: 

  

 

High voltage! Danger to life! 

While the engine is running, there is danger to life through high voltage 
particularly in the area of the ignition system. The following parts should 
therefore not be touched or removed unless explicitly stated otherwise: 

– Ignition coils and caps 

– Wires of the high voltage circuit 

– In- and output wiring of the ignition controller 

– Pickups and their wiring 

    

  

Danger to persons with pacemakers! 

Electromagnetic impulses in the wiring of the ignition system may exceed 
the permissible limits of pacemakers. Persons with pacemakers must 
therefore not be present in the vicinity of the ignition system being 
operated. Mark the operating location of the ignition system with the 
corresponding standardized warning symbol. 

     

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to 
operate. Nevertheless the equipment can cause risks or damage can occur, if the following 
instructions are not complied with: 

– The gas engine must only be operated by trained and authorized personnel. 

– Observe all safety instructions of the system and all safety instructions of the system 
operator. 

– Operate the equipment only within the parameters specified in the technical data. 

– Use the equipment correctly and for its intended use only. 

– Never apply force. 

– For all work such as installation, conversion, adaptation, maintenance, and repair, all 
equipment must be disconnected from the mains and secured against unintentional 
reactivation. 

– Perform only such maintenance and repair work as is described in this operating manual, 
and follow the instructions given while working. 

– Only use spare parts supplied by MOTORTECH for the maintenance of the device. 

– Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance with the instructions will void any warranties for the proper function of the 
equipment as well as the responsibility for the validity of the certifications. 

2 Safety Instructions 
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– Safety devices must not be dismounted or disabled. 

– Avoid all activities that can impair the function of the equipment. 

– Operate the equipment only while it is in proper condition. 

– Investigate all changes detected while operating the gas engine or ignition system. 

– Ensure compliance with all laws, directives, and regulations applicable to the operation of 
your system, including such not expressly stated herein. 

– If the system is not entirely tight and sealed, gas may escape and result in explosion hazard. 
The inhalation of gas can also lead to death or severe health damages. Therefore, upon 
completion of all assembly works, always check the system's tightness. 

– Always ensure adequate ventilation of the engine compartment. 

– Ensure a safe position at the gas engine. 

– There is a risk of burning on hot surfaces. Allow the gas engine to cool down before starting 
any work. 

– Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all 
work on the gas engine. 

– Noise from the system can cause permanent or temporary damage to your hearing. Wear 
suitable hearing protection at the system. 

– Your behavior can reduce possible residual risks to a minimum. Observe responsible 
handling of the gas engine and the gas-carrying system. 

 

2.2  Electrostatic Discharge Hazards 
Electronic equipment is sensitive to static electricity. To protect these components from damage 
caused by static electricity, special precautions must be taken to minimize or prevent 
electrostatic discharge. 

Observe these safety precautions while you work with the equipment or in its vicinity. 

– Before performing maintenance or repair work, ensure that the static electricity inherent to 
your body is discharged. 

– Do not wear clothing made from synthetic materials to prevent static electricity from 
building up. Your clothing should therefore be made of cotton or cotton mix materials. 

– Keep plastics such as vinyl and Styrofoam materials as far away from the equipment as 
possible. 

– Do not remove the circuit boards from the housing of the device. 
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2.3  Information on Electric Isolation 
If ground and earth potential are not properly isolated, the following problems as well as others 
can occur: 

– Electromagnetic interferences (e.g. ground loops) 

– Signal corruption (e.g. of the analog voltage signal) 

– Unwanted leakage currents 

Therefore, earth potential and the negative pole of the power supply of all devices in the electric 
assembly that provide the option, should be connected separately. If possible, the negative pole 
of the power supply should only be connected to earth potential at one point in the entire 
system. 

Wiring Example 
      Device with 

shielded wires 
Device featuring 
protection class II 

 

    



2 Safety Instructions 
 

14 Rev. 07/2021 

 

Occurrence of ground loops 

The devices shown in the following image do not feature the possibility to 
connect the earth potential and the negative pole of the power supply 
separated from each other. How ground loops are created. 

A ground loop is a ground connection of an electric wiring assembly that is 
closed as a loop. Due to impedance (resistance R > ) of the loop, low-
frequency interference currents can lead to an unwanted voltage drop in the 
signal path. 

  Device 1   Device 2 

 
    Ground loop   
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2.4  Special Safety Instructions for the Device 
  

 

Danger to life! Hazardous residual voltage! 

After stopping the ignition, there is dangerous residual voltage for up to 
three minutes in the ignition system. Do not touch any components of the 
ignition kit during this time. 

    

 

Explosion hazard! 

If the system is located in a hazardous area, never open the device (e.g. by 
opening the service screw or removing covers). There is a risk of explosion. 

    

 

Explosion hazard! 

The replacement of parts or assemblies can impair compliance with CSA 
Class I, Division 2 (Group C, D), T4. 

     

 

Explosion hazard! 

Do not disconnect any connectors while the system is live. If the system is 
located in a hazardous area, there is a risk of explosion. 

    

 

Explosion hazard! 

Never remove the equipment while the unit is connected to a power source. 
If the system is located in a hazardous area, there is a risk of explosion. 

     

 

Explosion hazard! 

Do not remove or replace the fuse while the equipment is live. 
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Risk of burning!  

The surfaces of the system may heat up to high temperatures. 

    

 

Operational safety! 

All connector screws and screw joints must be adequately tightened. 

    

 

Operational safety! 

The proper functioning of the device is only guaranteed if the device is 
operated within the permissible supply voltage range. Therefore, use a 
power supply in accordance with the specifications in the operating 
manual. 

      

 

Risk of destruction! 

Magnetic fields and heat occur when welding, which may damage or 
destroy the MIC3+. Therefore, pay attention to the following when welding: 

– Disconnect all electrical connections to the MIC3+ prior to welding. 

– Protect the MIC3+ against direct contact with the welding unit and 
magnetic fields, sparks and liquid metal. 

    
 

2.5  Proper Disposal 
After the expiration of its service life, MOTORTECH equipment can be disposed of with other 
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally 
friendly disposal. 
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3.1  Functional Description 
The devices of the MIC3+ series are microprocessor controlled ignition systems, each consisting 
of a board with a 32 bit main processor (CPU). 

Please note that the manufacturer is not required to implement configurations of the ignition 
controller for specific engines, and that devices may be delivered without pertinent 
configuration. 

The ignition controllers of the MIC3+ series use information supplied by the pickups to precisely 
determine the correct timing for the respective outputs. The ignition timing is influenced by 
various inputs. This can be implemented using analog input signals, a speed characteristic, or 
using a serial interface (USB, CAN bus, RS485). The devices can also be equipped with an 
optional potentiometer for ignition timing adjustment. 

During operation, the ignition controllers continuously monitor the system status of all installed 
pickups and the correct operation of the primary ignition circuit by checking the information 
received. 

Depending on the severity of an error that is detected, the device will shut down immediately or 
warn the operator. A corresponding message can be viewed on a connected computer. 

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off. 
 

3.2  Applications 
The ignition controllers of the MIC3+ series are designed for specific 2- or 4-stroke gas engines. 
From 1 to max. 12 ignition outputs are available. The ignition controllers supply the energy 
required for the corresponding ignition coils of the gas engines and can supply signals for 
peripheral equipment. 

Any use other than the one described in the operating manual shall be considered improper use 
and will result in the voiding of all warranties. 

 

3 Intended Use 
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4.1  Technical Data 

4.1.1 Certifications 
The ignition controllers of the MIC3+ series are certified as per the following 
directives/regulations: 

CE 
– EMC Directive 2014/30/EU 

– EN 61326-1:2013 – Electrical equipment for measurement, control and laboratory use. 
EMC requirements. General requirements 

– EN 55011:2009 + A1:2010 – Industrial, scientific and medical equipment. Radio-
frequency disturbance characteristics. Limits and methods of measurement 

– EN 61000-6-2:2005 + AC:2005 – Electromagnetic compatibility (EMC). Generic 
standards. Immunity for industrial environments 

– EN 61000-6-4:2007 + A1:2011 – Electromagnetic compatibility (EMC). Generic standards. 
Emission standard for industrial environments 

– Low Voltage Directive 2014/35/EU 

– EN 61010-1:2010 – Safety requirements for electrical equipment for measurement, 
control, and laboratory use. General requirements 

– EN 60529:1991 + A1:2000 + A2:2013 – Degrees of protection provided by enclosures (IP 
Code) 

– RoHS Directive 2011/65/EU 

CSA 
– CSA Std C22.2 No. 0 -10 

– CSA Std C22.2 No. 142-M1987 (R 2004) 

– CSA Std C22.2 No. 213-M1987 (R 2004) 

– ANSI/ISA 12.12.01, Ed. 1 (2007) 

– UL Std No. 916, Ed. 3 (1998) 
 

4 Product Description 
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4.1.2 Mechanical Data 
The MIC3+ has the following mechanical characteristics. 

Feature Value 

Dimensions Light Duty Version: 
251 mm x 240 mm x 90.99 mm (9.90" x 9.45" x 3.58") 
(length x width x height) 

Heavy Duty Version: 
251 mm x 240 mm x 107.5 mm (9.90" x 9.45" x 4.23") 
(length x width x height) 

Weight Light Duty Version: 
3.1 kg (6.8 lbs) 

Heavy Duty Version: 
3.8 kg (8.4 lbs) 

Shape of device See chapter Overview Drawings on page 26 

Mechanical environmental 
conditions 

The housing is resistant to general atmospheric 
contaminations. 

Resistant to gas engine lubricants. 

Protection class: I 
Protection: IP69 

The specified protection class and type is only 
guaranteed if all external cable connections are 
connected according to the connector specification and 
the protective cap is firmly attached to the USB 
connection.  

Climatic environmental 
conditions 

Housing surface temperature: 

Light Duty Version: 
 –40 °C to +60 °C 
(–40 °F to +140 °F) 

Heavy Duty Version: 
 –40 °C to +70 °C 
(–40 °F to +158 °F) 

Max. 85 % humidity without condensation up to 3,000 m 
(9,842') above sea level  
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4.1.3 Warning Notices on the Device 
  

 

Validity of warning notices on device 

The warning notices on the device are valid for the MIC3+ and all 
components connected to it. 

  

Warning notice on the 
device German translation French translation 

WARNING! Read and 
understand the installation 
and operating manual prior to 
installing or making any 
adjustments. 

WARNUNG! Lesen und 
verstehen Sie die In-
stallations- und Betriebs-
anleitung vor der Installation 
und bevor Einstellungen 
vorgenommen werden. 

ATTENTION! Lisez et 
comprenez le manuel 
d’installation et d’utilisation 
avant d’installer ou 
d’effectuer une modification. 

EXPLOSION HAZARD! Do not 
disconnect while circuit is 
live unless area is known to 
be non-hazardous. For wiring 
details refer to the operating 
manual. 

EXPLOSIONSGEFAHR! Keine 
Verbindungen lösen, solange 
der Stromkreis aktiv ist, 
außer das Umfeld wird als 
nicht explosionsgefährdet 
eingestuft. Hinweise zur 
Verkabelung finden Sie in der 
Betriebsanleitung. 

AVERTISSEMENT - RISQUE 
D'EXPLOSION! Ne pas 
débrancher tant que le circuit 
est sous tension, à moins 
qu'il ne s'agisse d'un 
emplacement non dangereux. 
Pour plus de détails de 
câblage, veuillez consulter le 
manuel d´utilisation. 

CAUTION! Do not pressure 
wash this device. Damage to 
electronic components may 
result. 

ACHTUNG! Das Gerät nicht 
mit Hochdruck reinigen. Es 
könnte zu Schäden an den 
elektronischen Bauteilen 
führen. 

ATTENTION! Ne pas laver cette 
boîte de contrôle en utilisant 
un jet sous pression. Cela 
pourrait endommager les 
composants électroniques. 

  

Warning Symbol on Device 
  

 

Warning of hot surface 
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4.1.4 Product Identification – Labeling on the Device 
The necessary numbers for unique product identification are on the device: 

– Part number of the ignition controller (P/N) 

– Arrangement number of the ignition controller (A/N) 

– Serial number of the ignition controller (S/N) 

 
 

4.1.5 Electrical Data 
The MIC3+ has the following electrical characteristics. 

Feature Value 

Power consumption Max. 65 W at 24 V 

Power supply Nominal voltage: 24 V DC 
Operating voltage: 10 V DC to 32 V DC 

Required current Max. current 7.0 A. An estimation of the power requirements can 
be found after this table. 

Number of outputs 6 or 12 outputs 

Firing angle The size of the firing angle depends on the max. overspeed. The 
smallest ignition angle can be calculated using the following 
formula: 
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Feature Value 

Ignition frequency With full energy output (all 12 ignition outputs with 300 mJ), an 
ignition frequency of 180 Hz as continuous load is possible. With 
less ignition energy or in case of a brief overload, 200 Hz is 
possible. The maximum output load of 60 W must not be 
exceeded. 

2-stroke engine: 

 

4-stroke engine: 

 

  

Estimation of Current Requirements 
These current values are based on a nominal speed of 1800 rpm and 300 mJ energy. 

Outputs Voltage Required current Voltage Required current 

6 24 V 2.1 A 12 V * 3.9 A 

12 24 V 3.3 A 12 V * 6.4 A 

 
* Nominal voltage 24 V DC 

Electrical Data for Inputs and Outputs 
The inputs and outputs of the ignition controller have the following electrical data:  

Inputs and outputs Values 

Analog current input Current range: 0 mA to 20 mA (adjustable in MICT) 
Input impedance: 27 Ω || 1 μF 

Analog voltage input Voltage range: 0 mA to 10 mA (adjustable in MICT) 
Input impedance: 12.4 kΩ || 200 nF 

Auxiliary analog input 
supply voltage 

5 V to 24 V/50 mA depending on the configuration in the MICT 
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Inputs and outputs Values 

Binary input (Start/Stop) Wiring 

Input current: max. 20 mA 
Ignition stop: 0 V to 0.8 V (low level) 
Ignition release: 2.8 V to 32 V (high level) 

Binary input (schedule A/B) Wiring 

Input current: max. 20 mA 
Schedule A: 0 V to 0.8 V (low level) 
Schedule B: 2.8 V to 32 V (high level) 

Binary input (GPI, general 
purpose input) 

Wiring 

Input current: max. 20 mA 
Low level: 0 V to 0.8 V 
High level: 2.8 V to 32 V 

(Function dependent on the configuration in MICT, see 
Inputs/Outputs – Inputs on page 105) 

Go/NoGo and GPO outputs One GPO (General Purpose Output) and one Go/NoGo output 

Implementation as optical MOSFET relay 

Maximum switching voltage: 32 V DC 

Peak/steady current: max. 100 mA DC 

Output power: max. 2.5 W 

Internal resistance: 58 Ω to 60 Ω 

Activation delay: 0.5 ms / max. 100 mA load 

Deactivation delay: 0.2 ms / max. 100 mA load  

If a short is found at the output, a safety circuit, which makes 
the output highly resistive, is found at the output, so that the 
current sets itself at 50 mA to 60 mA. 

LED Five LEDs are used as status indicators. 

ASO output TTL level (5 V) 
max. current: ± 10 mA 
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Inputs and outputs Values 

Pickup input Impedance: 10 kΩ 

The voltage supply for inductive pickups can be set using the 
MICT from 5 V to 24 V. 

Max. frequency for the pickups: 10 kHz 

The formula for determining the frequency of the pickups can 
be found in the note following this table. 

For a pickup output impedance of 120 Ω to 10 kΩ, the pickups 
connected to the MIC3+ may not have a higher voltage than 
±40 V and the connected power may not exceed 1 W. 

Ignition coil outputs Output voltage: max. 250 V 

Output energy in normal operation: max. 300 mJ (depending 
on the ignition coils used) 

Output energy in the start phase: max. 500 mJ  

  

 

Frequency of the pickups 

The frequency of the pickup is calculated as per the following formula. 
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4.1.6 Interfaces 
Depending on the device version, the following interfaces are available: 

USB Interface 
– Compatible with USB 1.1 and higher 

– The connector type B is only suitable for temporary data exchange and not for a permanent 
connection. 

– Max. wire length 5 m (16.4') 

CAN Bus Interface 
– Classical Extended Frame Format (CAN 2.0B) 

– As per ISO 11898 standard, 50 kbit/s to 1 Mbit/s 

– Protected against transients (automotive classification) 

– Max. 110 participants 

– Max. wire length 250 m (820') depending on the transfer rate 

RS485 Interface 
– According to TIA-485-A (03/2003) 

– Max. 32 participants 

– Max. data transfer rate 9.6 kbit/s to 115.2 kbit/s 

– Max. wire length 100 m (328') depending on the transfer rate 

  

 

Pay attention to the wiring diagrams 

Depending on the device version, certain signals or interfaces described in 
these instructions may not be available. You are also always to pay 
attention to the wiring diagrams enclosed with the input and output cable 
harnesses. 

  
 

4.1.7 Requirements for External Equipment 
External equipment shall fulfill the input and output specifications of the MIC3+. 
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4.1.8 Overview Drawings 
The connectors shown correspond to the standard version. 

Plan View 
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Front View Light Duty Version 

 

Front View Heavy Duty Version 

 

USB Connection 
A USB connection is located at the front of the device to connect the MIC3+ to a computer. 
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4.1.9 LED Functions 

 

Labeling Function 

Status Up to firmware version 1.11.00000: 

LED flashes green if the device is running with no errors. 
The LED flashes red if an error has occurred. 
The LED flashes yellow if a warning has occurred. 

As of firmware version 1.11.00000: 

LED flashes green if the device is running with no errors. 
The LED flashes red if an error has occurred. 
For details, refer to the following overview. 

The firmware version of your device can be found in the MICT in the 
window Runtime Data – Information. Refer to the section Runtime Data – 
Information on page 136. 

Firing LED lights up when the ignition is active (exception: during the self test). 

Pickup 1 and 2 LEDs flash when the pickups are active. 

GPO LED is on when the GPO is activated. 

  

Indication via the Status LED (from firmware version 1.11.00000) 
The flashing sequences shown below are repeated until the device has left the respective state 
again. However, the flashing sequences are always executed to the end and are not interrupted 
accordingly. 

The status LED flashes green: 

– Waiting for sufficient supply voltage 
Fast flashing green/off 100 ms 

        

  
– Synchronization/ Firing active 

Flashing one time green 250 ms on, 750 ms off 
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– Ready for operation 
slow flashing green/off 500 ms 

        

  
– Bootloader – connection to computer started/ update mode 

Flashing one time green 2,000 ms on, 250 ms off 

        

  
– Firing locked 

3 flashes green/off 250 ms, 750 ms off 

                

  
– Configuration/ Wait for 0 RPM 

6 flashes green/off 250 ms, 750 ms off 

                          

  
  
The status LED flashes red: 

– Critical error/ Assertion 
fast flashing red/off 100 ms 

        

  
– Operating error – general/ System error 

slow flashing red/off 500 ms 

        

  
– Bootloader – faulty firmware 

Flashing one time red 2,000 ms on, 250 ms off 

        

  
– Operational error – pickup 

2 flashes red/off 250 ms, 750 ms off 
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– Operational error – overspeed 
4 flashes red/off 250 ms, 750 ms off 

                    

  
– Operational error – insufficient supply voltage 

5 flashes red/off 250 ms, 750 ms off 

                        

  
  
The status LED flashes orange: 

– Selftest 
Flashing one time orange 250 ms on, 750 ms off 
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5.1  Unpacking 
Unpack the equipment, taking care not to damage it. Always place the device safely and 
protected from falling over or falling down. Ensure that the operating manual is always stored 
with the ignition controller and is easily accessible. Check the contents for completeness and 
verify that the device type meets your application requirements. 

Scope of Supply 
The scope of supply of the MIC3+ ignition controller consists of the following components: 

– Ignition controller of the MIC3+ series 

– Installation set incl. four vibration dampers 

– Ground strap 

– Three multiple sealing inserts and five sealing plugs for PG screw joints 

– Storage device (USB flash drive or CD-ROM) with software for configuring the ignition 
controller 

– USB interface cable for connecting the ignition controller to a computer 

– Operating manual 
 

5.2  Installation of the Ignition Controller 
The installation of the MIC3+ ignition controller is implemented on a fixed bracket e. g. on a wall 
near the engine. Use the included rubber vibration dampers and the ground strap. The 
installation location of the controller must be selected so that the distance to the pickups 
installed on the engine ensures a reliable signal transmission to the ignition controller, and so 
that there is adequate space for maintenance and repair work. The mechanical specifications 
must always be complied with (refer to Mechanical Data on page 19). The ground strap serves to 
ground the ignition controller and must be used accordingly. Ensure a flawless electrical 
connection for this purpose. 

Installation locations where strong vibrations or extreme ambient temperatures are present are 
not permissible and result in the warranty being voided. The permissible temperature range is: 

–40 °C (–40 °F) to +60 °C (+140 °F) 

  

 

Risk of destruction! 

The device must not be installed directly on or at the engine, as vibration 
and heat may cause damage to electronic components. This also applies if 
vibration dampers are used. 

  
 
 

5 Installation Instructions 
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5.2.1 Installation of the Vibration Dampers 
There are two options for using the vibration dampers from the MIC3+'s scope of supply. The 
hole patterns can be found in section Overview Drawings on page 26. 

  
Option A   

 

1. Fasten the four vibration dampers  to the 
selected installation location. Use four 
screws M8x16 , four rim lock washers 
M8  and four washers M8 . 

2. Fasten the MIC3+ to the vibration dampers. 
Use four washers M8  and four lock nuts 
M8 . 

▸ Fasten the ground strap to the ground 
pin (see Installation of the Ground 
Strap on page 33). 
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Option B   

 

1. Fasten the four vibration dampers  to the 
MIC3+. Use four screws M8x16 , four rim 
lock washers M8  and four washers 
M8 . 

2. Fasten the MIC3+ to the selected 
installation location using the vibration 
dampers. Use four washers M8  and four 
lock nuts M8 . 

▸ Fasten the ground strap to the ground 
pin (see Installation of the Ground 
Strap on page 33). 

  
 

5.2.2 Installation of the Ground Strap 
  

 
  

(schematic representation) 

1. Fasten the ground strap  to the MIC3+ 
ground pin. To do so, use one washer 
M6 , one tooth lock washer A6  and 
one poly lock nut M6 . 

2. Connect the ground strap to one of the 
sides suitable for grounding. 

▸ You can wire the ignition controller as 
described in section Wiring of the 
Device on page 35. 
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5.3  Determine the Installation Location of the Pickup 
Set the positions of the pickups depending on engine type and application. All angle reference 
information is based on: 

TDC 1st cylinder / compression cycle 

The installation location for the pickups must have adequate mechanical strength and must not 
exceed the specified temperature ranges. The pickups are designed for the appropriate use 
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate 
the calibration of the sensor. Comply with the pertinent regulations for the wire routing. 

For the exact positioning of the individual pickups, refer to the examples given in the drawings 
(see section Input Wiring – Pickups on page 39). 

 



 
 

Rev. 07/2021 35 

6.1  Input and Output Wiring on the Controller 
  

 

Operational safety! 

All connector screws and screw joints must be adequately tightened. 

   

 

Assignment of the wire colors 

Take the assignment of the wire colors of the wiring harness for the input 
and output wiring from the wiring diagram enclosed with the wiring 
harness. 

    

 

Pay attention to the wiring diagrams 

Depending on the device version, certain signals or interfaces described in 
these instructions may not be available. You are also always to pay 
attention to the wiring diagrams enclosed with the input and output cable 
harnesses. 

  
 

6 Wiring of the Device 
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6.1.1 Input Wiring 
Input Connector 

 

35-pole input connector (outside view) 

  

Pin Assignment Pin Assignment 

A L + (24 V) V ASO + 

B L – (negative pole) W ASO – 

C Pickup 1 Power X ASO Shield 

D Signal Y RS485 TX + 

E GND Z TX – 

F Shield a Com 

G Pickup 2 Power b RX + 

H Signal c RX – 

J GND d Analog GND 

K Shield e Analog Power 

L CAN Hi f Timing I in – 

M Com g Timing I in+ 

N Lo h Analog Shield 

P Shield j Start/Stop + 

R Go/NoGo + k Schedule A/B + 

S Go/NoGo – l GPI1 + 

T GPO + m Binary Com 

U GPO –   
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6.1.2 Input Wiring – Power Supply 
    

 

Operational safety! 

The proper functioning of the device is only guaranteed if the device is 
operated within the permissible supply voltage range. Therefore, use a 
power supply in accordance with the specifications in the operating 
manual. 

    

 

Design of power supply 

For the power supply, an overcurrent protection mechanism must be set up 
with a circuit breaker (16 A DC with tripping characteristic B), which allows 
switching off. When selecting the circuit breaker, the conditions of the 
installation site and the ambient temperature must be considered. The 
circuit breaker must be easy for the user to access and marked as a 
disconnecting device for the ignition controller. 

If the power is supplied via a power supply unit, the following specifications 
must be observed additionally: 

– Voltage: 24 V DC; Current: at least 25 A 

– Wiring: at least 1.5 mm² cross-section 
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L ≙ 24 V DC (nominal voltage) 

 

  

Variations 

1 Battery Generator Control unit 

  

 

2   Power supply 

  

 

3   Battery Charger 
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6.1.3 Input Wiring – Pickups 
Example Configuration (one Active, one Passive Pickup) 

 

 

Camshaft 

 

 

 

 

 

Crankshaft 

 

 

 

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH 
pickups. Please note that additional fine-tuning is required for every pickup position due to the 
different conditions of the engines. 
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One revolution of the pickup changes the distance as follows: 

Thread Change in distance 

M12x1 1 revolution ≙ 1 mm (0.04'') 

5/8"-18 UNF 1 revolution ≙ 1.41 mm (0.05") 

3/4"-16 UNF 1 revolution ≙ 1.59 mm (0.06") 

  

Allocation of the Wire Colors (Example Configuration) 
 
Camshaft 

PIN Designation Wire color 

C Pickup 1 Power Brown 

D Pickup 1 Signal black 

E Pickup 1 GND blue 

F Pickup 1 Shield Shield 

  
Crankshaft 

PIN Designation Wire color 

H Pickup 2 Signal White 

J Pickup 2 GND Brown 

K Pickup 2 Shield Shield 

  

For problems with the pickup signals, refer to the section Pickup Input Errors on page 158. 

  

 

Adjusting the pickup sensitivity 

Depending on the type of impulse source (interference), it may be necessary 
to increase the pickup sensitivity to ensure that the resultant signal 
strength is sufficient for reliable operation. You can make these 
adjustments in the MICT. Refer to the section Engine – Pickups on page 91. 

   



6 Wiring of the Device 
 

Rev. 07/2021 41 

 

Aux. pickup supply voltage 

An auxiliary supply voltage for active pickups can be configured using the 
MICT. The voltage can be set in the range from 5 V to 24 V and is supplied at 
the connections Pickup 1 Power to Pickup 2 Power. Refer to the section 
Engine – Pickups on page 91. 

  
 

6.1.4 Input Wiring – Timing and Safety Devices 
Example Configuration 

 

*) See subsequent drawings for details 

 
x = bridge for permanent authorization 

 

Switch Start/Stop 

open Ignition – OFF 

closed Ignition – ON 

 

Switch A/B 

open Schedule A 

closed Schedule B 
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Two-Wire Transmitter 

 

Four-Wire Transmitter 

 

     

 

Auxiliary analog input supply voltage 

An auxiliary supply voltage for the analog inputs can be configured using 
the MICT. The voltage can be set in the range of 5 to 24 V and is made 
available on the connection Analog Power. Refer to the section Timing – 
Analog Inputs on page 95. 
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Wiring MIC3+ ignition controller and DetCon detonation control system 

The following diagram shows an example of the wiring of a MIC3+ ignition 
controller with a DetCon detonation control system in cases where the 
analog current signal (4-20 mA) at the output I out is to be used for the 
ignition timing adjustment. 

  

  

MIC3+- 
ignition 
controller 

  

  

  

  

DetCon  
detonation  
control system 

  

Furthermore, the limits of the analog current input will need to be set at 
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to 24 V 
in the MICT. Refer to the section Timing – Analog Inputs on page 95. 

The timing is transmitted by MIC3+ via the auxiliary synchronization output 
(ASO) to the DetCon, and will need to be wired and configured accordingly. 
Refer to the section Output Wiring – Binary Outputs (Go/NoGo, GPO, ASO) 
on page 44. 

    

 

General purpose input GPI 

The general purpose input GPI can be assigned various functions via the 
configuration. Refer to the section Inputs/Outputs – Inputs on page 105. 
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6.1.5 Output Wiring – Binary Outputs (Go/NoGo, GPO, ASO) 
Example Configuration 

 

  

  

  

  

*) DetCon or other external device (for wiring 
of the DetCon, see following example) 

K1 = Go/NoGo relay 

K2 = GPO relay 

L ≙ 7 V DC to 32 V DC 

  

  
(L ≙ 7 V DC to 32 V DC)   
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DetCon connection 

Connect the ASO output on the DetCon to the connections in A and in B on 
connector Synchronization. 

 

  
 

6.1.6 Wiring – PowerView3 
Connect the PowerView3 visualization unit to the MIC3+ as follows. 

CAN Connection between Ignition Controller and PowerView3 
As shown in the following illustration, you can connect the PowerView3 directly to the 
MOTORTECH ignition controller using the CAN cable delivered with the PowerView3. To do so, 
you need to insert the connector in the CAN interface on the PowerView3. On the ignition 
controller, connect the color-coded conductors of the CAN cable to the correct CAN interface 
connections. 
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Connector for CAN 
interface on PowerView3 

  
  
  
  
  
  
  
  
CAN interface on the 
ignition controller 

  

PowerView3 Power Supply via the Ignition Controller 
If you use a MOTORTECH ignition controller with a service cover and connector strip, you have 
the option of supplying power to the PowerView3 via the ignition controller. A special connector 
is included in the PowerView3's scope of supply. The connector for the voltage supply of the 
ignition controller must be replaced by this one. 

  
Connector supplied with 
the ignition controller: 

Connector supplied with 
PowerView3: 

  

  
Proceed as follows: 

1. Disconnect the power supply to the ignition controller and, if necessary, to the PowerView3. 

2. Remove the connector for the power supply from the ignition controller. 

3. Negative terminal: Disconnect the conductor from the contact  and insert it into contact  
of the connector provided with the PowerView3. 
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4. Positive terminal: Disconnect the conductor from the contact  and insert it into contact  
of the connector provided with the PowerView3. 

5. From the PowerView3 power supply cable, plug the L– wire (white) into contact . For 
plugging into the contact, use a wire end ferrule provided with the PowerView3. 

6. From the PowerView3 power supply cable, plug the L+ wire (brown) into contact . For 
plugging into the contact, use a wire end ferrule provided with the PowerView3. 

7. Insert the connector provided with the PowerView3 into the power supply connection of the 
ignition controller. 

8. Insert the connector at the other end of the PowerView3 power supply cable into the 
PowerView3 power supply connection. 

9. Connect the device's power supply. 

▸ The power supply of the PowerView3 is now provided through the connector on the 
ignition controller. 

 

6.1.7 Output Wiring – CAN Bus Interface 
The wiring of the ignition controller of the MIC3+ series is carried out as standard via a 
MOTORTECH wiring harness. This contains a 120 Ω terminating resistor for the CAN bus. The 
devices must therefore be used at the bus end.  

  
  First device Second-to-last device 

 

   Second device Last device 
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CANopen® protocol 

If you require information on the CANopen® protocol, contact your 
MOTORTECH contact person. 

   

 

CAN bus wiring 

Note the following when connecting the CAN bus: 

– Each bus end must be fitted with a terminating resistor of 120 Ω (see 
drawing). 

– The maximum wire length depends on the bit rate: 

Bit rate Maximum wire 
length 

Maximum length 
of a stub 

Maximum length of 
all stubs 

1 Mbit/s 25 m (82') 1.5 m (5') 7.5 m (25') 

800 kbit/s 50 m (164') 2.5 m (8') 12.5 m (41') 

500 kbit/s 100 m (328') 5.5 m (18') 27.5 m (90') 

250 kbit/s 250 m (820') 11 m (36') 55 m (180') 

125 kbit/s 500 m (1,640') 22 m (72') 110 m (360') 

50 kbit/s 1,000 m (3,280') 55 m (180') 275 m (902') 

  

– Only use cables that are specified by the manufacturer for use in the 
CAN bus. 

  
 



6 Wiring of the Device 
 

Rev. 07/2021 49 

6.1.8 Output Wiring – RS485 Interface 
The RS485 interface can be wired as two-wire or four-wire wiring and twisted cables must be 
used. With both variants the load resistance (RT=120 Ω) is the characteristic impedance of the 
cable. 

Two-Wire Wiring 
  
First device     Last device 

 
  Second device Second-to-last device   

Four-Wire Wiring 
  
First device 
(Master) 

    Last device 
(Slave) 

 
  Second device 

(Slave) 
Second-to-last device 
(Slave) 
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Connection on the Ignition Controller 

 

  

 

Wiring of the RS485 interface 

Follow these instructions for the RS485 interface wiring: 

– Max. 32 devices can be connected to a bus. 

– The maximum wire length is 100 m (328') depending on the transfer 
rate. 

– Each bus end must be fitted with a terminating resistor with 120 Ω in 
each pair of leads (as indicated in the drawing). 

  
 

6.2  Ignition Coil Wiring 
  

 

Protection when using wiring rails 

Every wiring rail on the engine block should be grounded to avoid 
disruptions in the device caused by secondary current in the ignition coils. 
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Ignition coil wiring 

In the MICT there are two types of wiring with predefined output 
configuration supported in the engine database for many engines: 

– Wired in straight order 

– Wired in firing order 

For information on straight order wiring refer to Straight Order Wiring of the 
Ignition Outputs on page 52 and Engine – Parameters on page 83. 

For wiring in firing order, the first cylinder in the firing order is connected to 
the A1 output, the second to A2, etc. 

If a different wiring was implemented, the output configuration in the MICT 
must be adapted accordingly. Please note that the wiring cannot be 
checked by the software (see section Engine – Parameters on page 83). 

    

 

Conductor cross-section for primary wiring 

If you do not use a harness manufactured by MOTORTECH, the primary 
wiring must have a conductor cross-section of 1.5 mm². 

  

  

17-pole connector (outside view) 
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The table shows the pole assignments for the standard 6 and 12 cylinders versions of the MIC3+. 

Pole 12 outputs 6 outputs 

A Output A1 Output A1 

B Output A2 Output A2 

C Output A3 Output A3 

D Output A4 Output A4 

E Output A5 Output A5 

F Output A6 Output A6 

G Output A7 Not assigned 

H Output A8 Not assigned 

J Output A9 Not assigned 

K Output A10 Not assigned 

L Output A11 Not assigned 

M Output A12 Not assigned 

N Not assigned Not assigned 

P Not assigned Not assigned 

R Not assigned Not assigned 

S Not assigned Not assigned 

T Ground Ground 

 
 

6.3  Straight Order Wiring of the Ignition Outputs 
  

 

Risk of damage to engine 

If you use MOTORTECH wiring rails for straight order wiring, it is absolutely 
necessary that they are correctly selected and installed for the respective 
engine. Even a rotated installation can cause serious damage to the engine, 
for example. 

  
Straight order wiring, along with wiring in firing order, is supported by the MICT for many 
engines with predefined output configurations in the engine database. That means that if the 
wiring is carried out accordingly and the option Wired in Straight Order is selected in the MICT, 
no other adaptation of the output configuration is necessary. 
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You can use straight order wiring, if: 

– Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH 
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing 
order needs to be configured directly in the ignition controller. The ignition coils on the 
wiring rail are identified with Connector Pin 1 to Connector Pin X. 

– Make the wiring of the ignition controller corresponding to the instructions in the following 
sections (for example with an open wiring harness or via a junction box). 

The execution of straight order wiring is dependent on the type of engine (in-line or V-engine). 

Version with 6 Outputs 

Pole 6 outputs In-line engine V-engine 

Connector* Coil** Connector* Coil** 

A Output A1 1 1 1 1 

B Output A2 1 2 2 1 

C Output A3 1 3 1 2 

D Output A4 1 4 2 2 

E Output A5 1 5 1 3 

F Output A6 1 6 2 3 

G –     

H –     

J –     

K –     

L –     

M –     

N –     

P –     

R –     

S –     

T Ground     

  
Connector* = connector on the wiring rail 
Coil** = ignition coil with the corresponding number on the wiring rail 
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Version with 12 Outputs 

Pole 12 outputs In-line engine V-engine 

Connector* Coil** Connector* Coil** 

A Output A1 1 1 1 1 

B Output A2 1 2 2 1 

C Output A3 1 3 1 2 

D Output A4 1 4 2 2 

E Output A5 1 5 1 3 

F Output A6 1 6 2 3 

G Output A7 1 7 1 4 

H Output A8 1 8 2 4 

J Output A9 1 9 1 5 

K Output A10 1 10 2 5 

L Output A11 1 11 1 6 

M Output A12 1 12 2 6 

N –     

P –     

R –     

S –     

T Ground     

  
Connector* = connector on the wiring rail 
Coil** = ignition coil with the corresponding number on the wiring rail 
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The ignition controllers of the MIC3+ series include freely configurable safety and auxiliary 
functions that, amongst others, can shut down the engine in case of fault. 

  

 

Angle indications in the operating manual 

All angles in this operating manual are given in °crankshaft. Exceptions are 
clearly identified. 

  
 

7.1  Pickup Sensitivity 
To increase the signal interference distance, the sensitivity of the pickup signal inputs can be 
changed for suitable pickup signals. This setting can be implemented individually for each 
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as 
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus 
result in a low pickup sensitivity level. 

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine – 
Pickups on page 91. 

 
 

7.2  Monitoring of Pickup Signals 
The MIC3+ monitors the pickup signals. Any other errors are displayed in the MICT. For more 
information on the errors, please refer to the overview in the section entitled Pickup Input Errors 
on page 158. 
 

7.3  Go/NoGo 
The binary output (Go/NoGo) is a potential-free output. It is closed during firing and opens when 
the ignition switches off. The max. switching current is 100 mA. The output can drive an external 
relay that e.g. opens a gas valve. 

The following errors can cause the ignition outputs to shut down: 

– Overspeed 

– Pickup error 

– Error HV power supply 

– Failure of the output monitoring 

– Overload/temperature shut-down 

– Alarms 

– Insufficient supply voltage (Low Power) 

  

7 Functions 
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Use master control 

The outputs of the MIC3+ are not SIL compliant. Therefore, always use an 
additional master control for safety-critical applications. 

  
 

7.4  Ignition Timing Adjustment 
The ignition controller has several functions for the timing correction. 

  

 

Influences on ignition timing 

Be aware that the actual timing of the engine can also be influenced by 
external signals (e.g., analog current or voltage input). 

   

 

Operational safety! 

The MIC3+ ignition controller must first be correctly configured for the 
engine being used before you can start the engine. 

An incorrect configuration can result in damage to the engine. 

  

The figure below gives you an overview of the different functions of the timing correction, which 
will be explained in more detail in the subsequent sections. Functions that can be activated/ 
disabled via the MICT are marked by a switch symbol. Depending on the device version, some 
functions might not be available. 
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 Per schedule:      

 Base Timing 

 

 

   

 Speed Curve  

   

 Analog Voltage Input  

   

 Analog Current Input  

   

 Potentiometer  

   

 Global:  

 Ignition Timing Correction  

     

 Per cylinder:    

 Cylinder Individual 
Offset 

 

 Limited by the 
min./max. Cylinder 
Individual Offset 

 

     

    Limited by the 
min./max. Timing 

 

       

 
 

7.4.1 Analog Inputs 
The timing point control can be adjusted with a linear current signal. This signal can be 
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a 
detonation controller. 

With the analog process signal (current loop signal) at the analog current input, the timing point 
can be offset in the advanced or retarded direction within a defined range. 
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Similarly or additionally, the timing can also be influenced by an analog voltage signal at the 
corresponding input. 

The levels of the analog inputs can be set in the range from 0 mA to 20 mA and 0 V to 10 V. You 
can make this configuration with the MICT. Refer to the section Timing – Analog Inputs on 
page 95. 

At the voltage output (Analog Power), a configurable auxiliary voltage is supplied that can be 
used for supplying power to external sensors. 

  

 

Configuration examples 

In this example the analog inputs are configured in the Timing – Analog 
Inputs window as follows: 

– Input current: 4-20 mA 

– Input voltage: 0-5 V 

Characteristic 4-20 mA / 0-5 V – Ignition timing adjustment toward 
retarded. 

 

Characteristic 4-20 mA / 0-5 V – Ignition timing adjustment toward 
advanced. 
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7.4.2 Cylinder-to-Cylinder Alignment 
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders 
to optimize their combustion. 

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to 
the chapter Cylinder Individual Offsets on page 144. 

  

 

Use of measuring unit 

Use this setup option only if a suitable measuring unit is available for 
determining the optimum timing point, so that the result of a change can be 
assessed immediately. 

  
 

7.4.3 Speed Curve 
To optimize the ignition, for example, during the start phase of the engine, a speed curve can be 
defined for the MIC3+ ignition controllers. To create this curve, up to eight adjustable speed 
points are available. 

You can configure the speed curve with the MICT. Refer to the section Timing – Schedule A/B – 
General on page 97. 
 

7.4.4 Ignition Timing Correction 
Via the ignition timing correction, the global ignition timing, limited by the timing limits of the 
current schedule, can be adjusted. Refer to the section Runtime Adjustments – Timing on 
page 140. 
 

7.5  Firing Angle 
The min. distance between two ignition angles depends on the overspeed. The smallest ignition 
spacing per output bank can be calculated using the following formula: 

  
 

7.6  HV-Power Supply Error Monitoring 
The voltage applied is monitored for excess voltage or low voltage by the integrated power 
supply. For both errors a Power-Fail error is saved and the device shuts off. 
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7.7  Output Monitoring 
Electronic switches are used for the ignition outputs of the MIC3+ ignition controller If one of 
these switches is defective, this would lead to a primary short or a primary open output. This can 
cause problems when operating the engine or can damage the engine. The function of the 
outputs is therefore monitored and errors that occur are displayed in the runtime data in the 
MICT or can be transmitted via field buses. Different alarms are available for monitoring the 
misfire rate. It can also be defined that the ignition is switched off in the event of output errors. 
Refer to the section Inputs/Outputs – Alarms on page 101. 
 

7.8  Schedules A/B 
The MIC3+ ignition controllers offer two separate schedules for the parameterization of the 
ignition timing and energy. 

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A 
possible application for this is e.g. operation with different gases. If only one schedule is 
configured, this is used regardless of the switch position. 

You can configure the schedules with the MICT. Refer to Timing – Schedule A/B – General on 
page 97 and Timing – Schedule A/B – Energy on page 99. 

  

 

Operational safety! 

If you use schedules A and B, the advanced timing point should be linked to 
schedule B (switch closure). If a wire ruptures, schedule A is automatically 
selected with the retarded (and thus safer) timing point. 

  
 

7.9  Alarms 
The MIC3+ ignition controllers include 16 freely configurable alarms in total. These alarms can 
be freely allocated to the general purpose output (GPO) and set depending on the following 
functions: 

– Limit for speed exceeded/not reached 

– Limit for engine operating hours exceeded/not reached 

– Limit for spark plug operating hours exceeded/not reached 

– Warning active 

– Error active 

– Limit for temperature exceeded/not reached 

– Limit for supply voltage exceeded/not reached 

– Limit for global ignition timing exceeded/not reached 

– Limit on the analog voltage input exceeded/not reached 
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– Limit on the analog current input exceeded/not reached 

– Limit of the minimum spark duration exceeded/not reached 

– Misfire rate (primary, single output) over limit 

– Misfire rate (primary, all outputs) over limit 

– Misfires per second (primary, all outputs) above threshold 

– Consecutive misfires (primary, single output) above threshold 

– Misfire rate (secondary, individual output) above threshold 

– Misfire rate (secondary, all outputs) above threshold 

– Misfires per second (secondary, all outputs) above threshold 

– Consecutive misfires (secondary, single output) above threshold 

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer 
to the section Inputs/Outputs – Alarms on page 101. 
 

7.10  GPO: General Purpose Output 
The function of the general purpose output (GPO) can be set as desired as normally closed or 
normally open. The GPO can be used for the freely definable alarms. 

You can enter the settings for the general purpose output with the MICT. Refer to the section 
Inputs/Outputs – Alarms on page 101. 
 

7.11  ASO: Auxiliary Synchronization Output 
The ASO is an output of the MIC3+ for synchronizing the MIC3+ ignition controller and a 
connected control unit. The possible applications include detonation control, valve control, and 
fuel injection control. 

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the 
raising and falling edge (pulse width = traising – tfalling). The raising edge of the signal marks the 
configured engine rotation angle. With the variable pulse width, the values can be allocated to 
the engine rotation angle. A max. of 12 pulses can be configured for this purpose. 

The pulse width is known at the time of the active edge, as the falling edge of the signal 
precedes the raising edge by the value of the pulse width. The controller calculates the duration 
of the falling edge from high-level to low-level and then back to the starting value of the high-
level. 

The ASO signal can be inverted via the configuration. It will then be high-active. 

You can configure the auxiliary synchronization output with the MICT. Refer to the section 
Inputs/Outputs – ASO1 (Auxiliary Synchronization Output) on page 103. 
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Application of the ASO signal 

The following example will illustrate the application of the ASO signal: 

– Four-stroke engine with 6 cylinders 

– Ignition angle 120° - 120° 

Synchronization between MIC3+ and Valve Controller 

Cyl. Ignition angle in 
°crankshaft 

ASO signal in 
°crankshaft 

Pulse duration in 
μs 

1 0/720 718 160 

2 120 118 80 

3 240 238 80 

4 360 358 80 

5 480 478 80 

6 600 598 80 

Schematic Representation (Standard Settings) 

 

*) active edge 

The valve controller should receive the active edge of the ASO signal before 
the top dead center of a cylinder. The first pulse duration should be twice 
as long and thus mark the beginning of a cycle. The ASO signal generated 
by the MIC3+ increases by 2° each time before the ignition signal from Low 
to High, as can be seen in the schematic drawing. This edge is analyzed by 
the valve controller as the active edge. 

The ASO signal drops in accordance with the configured pulse duration 
from High to Low before the active edge. The valve controller then has 
already measured the pulse duration of the active edge and can provide 
information on the allocation of the signal. In the example shown here, the 
first cylinder is marked with a pulse width of 160 μs versus 80 μs for other 
cylinders. If the valve controller measures a pulse width of 160 μs, the 
subsequent signal is therefore allocated to the first cylinder. The next 
signal then corresponds with the second cylinder in the ignition sequence, 
etc. 
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7.12  Ignition Energy 
The ignition energy can be set separately for the start phase and normal operation. Here 
different settings can be made for schedules A and B. 

You can configure the ignition energy with the MICT. Please refer to the section Timing – 
Schedule A/B – Energy on page 99. 
 

7.13  Access Control 
The MIC3+ has four operating levels, three of which can be secured with different PINs. As a 
default setting, the access control is not activated. If the access control for the MIC3+ is 
activated, it is independent from the access levels that control authorizations within the MICT. 

  

 

Access control in the MICT and on MIC3+ 

A user is logged in to the Advanced Service access level on the MICT. He 
changes a configuration and would like to download the change to the 
MIC3+. Although he has the full authorization set in the MICT, he is 
prompted to log in with the PIN for the Level 3 (Master) on the MIC3+. 

  
A variety of functions are at your disposal in the four operating levels of the MIC3+ . The figure 
below illustrates this: 
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The following functions are available on the different levels: 

– Level 0 (Read Only) 
Enables read-only access for all users. 

– Level 1 (Operator) 
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on 
this level. 

– Level 2 (Service) 
Only the Service level has access to modifications of the runtime adjustments for Timing and 
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual 
Offsets and the Settings for Self Test can also be executed in this operating level. 

– Level 3 (Master) 
On this level, the Master can, in addition to the other adjustments, modify the Reset Position 
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to 
transfer a configuration to an ignition controller. 

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on 
page 66. 
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MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can 
configure your ignition controller, and you can view and adjust the operating data of your 
engine. When working with the MICT, you can press the F1 key at any time to access context-
sensitive help. 

If you are using a different version of the MICT than shown in the following sections, the scope of 
functions may differ. 
 

8.1  MICT System Requirements 
For the installation of the MICT, the following minimum requirements must be fulfilled: 

– x86-compatible computer, at least performance class Intel Pentium 4 with 2 GHz 

– 128 MB free RAM 

– 250 MB free disk space 

– USB interface 1.1 or higher 

– Display with a resolution of at least 1440 x 900 pixels (WXGA+) 

– Microsoft® Windows 7, Windows 10 
 

8.2  MICT Installation 
The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM) 
provided with the ignition controller. 

To install the MICT, proceed as follows:  

1. Start the installation: 

– Via the menu: 
Start the file Start.exe on the storage device. Start the installation routine of the MICT 
via Software -> Install MICT. 

– Directly from the storage device: 
Start the installation routine of the MICT directly. It is on the storage device in the 
subdirectory Installation and for example named as follows: MICT-2.42.2-setup.exe. 

2. Run the installation. 
Follow the instructions of the installation routine. Note that the license agreement terms 
must be accepted before using the MICT. 

3. Install the USB driver via the menu as well or directly from the storage device. 

– Via the menu: 
Software -> USB Drivers -> Install USB Drivers 

– Directly from the storage device: 
Start the exe file in subdirectory Drivers (e.g. CDM21226_Setup.exe). 

▸ The MICT is set up. You can connect your PC to the ignition controller via the USB 
interface. 

 

8 Settings via the MICT 
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8.3  Access Levels in the MICT 
You can open the MICT on your computer via Start -> Programs -> MOTORTECH -> MICT 2.x.x -> 
MICT 2.x.x. 

After opening the MICT, select the access level for which you have clearance. The access level 
controls the options you have at your disposal in the MICT. The password required for access 
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on 
page 159). 

 

The following access levels are available: 

– Read Only 
On this level, the user can open a configuration and transfer it to the device. However, he 
cannot make changes to the configuration. The user has read-only access to all other 
settings. 

– Customer 
This level enables the configuration of the basic functions required for operation in addition 
to the read-only function. 

– Service 
This level contains all functions for a standard installation. 

– Advanced Service 
This level offers full access to all functions of the MICT and is enabled and accessible for 
specially trained personnel only. 

The following sections describe the options at your disposal with the Advanced Service access 
level. If you have registered for a different level, you cannot execute all functions shown. 
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8.4  Configuration Pages (Overview) 
The configuration pages are divided into the following sections: 

 

Pos. Area 

 Menu bar 

 Toolbar 

 Navigation bar 

 Configuration section 

 Status bar 

  
The functions in the menu bar, navigation bar and the toolbar as well as the configuration 
section will be described in the following. 
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The status bar provides you with the following information (from left to right): 

– Status display 
Indicates whether a connection is established with the device: 

– Green: Connection established 

– Red: The connection was interrupted and is being restored 

– Gray: The connection is not established and is not being restored 

– Indication of the interface being used for the connection to the device 

– Indication of the device ID 

– Indication of the access level of the user in the MICT 

– Indication of the operating level for the MIC3+ if access control has been activated and the 
user has logged on with a PIN. 

– Indication of the MICT program version 
 

8.5  Menu Bar and Toolbar 
The following functions are available to you via the symbols on the toolbar and the entries in the 
menu bar: 

Symbol Menu Function 

 

File -> New Creates a new configuration. 

 

File -> Open Opens an existing configuration. 

 

File -> Save / 
File -> Save As 

Saves the current configuration. 

  File -> Recent Documents The last five configuration files used are 
offered for selection. 

  File -> Close Closes the current configuration. 

  File -> Open trace Opens a runtime data record (trace file). Refer 
to the section Runtime Data on page 109. 

  File -> Open pickup trace Opens a saved record of pickup signals 
(putrace file). Refer to the section Pickup Trace 
on page 74. 

 

File -> Change Access Level Changes the MICT access level for accessing 
the configuration data and functions. 
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Symbol Menu Function 

 

File -> Print Prints the current configuration. 

 

File -> Print To PDF File Prints the configuration to a PDF file. 

  File -> Print Preview Opens a print preview of the configuration. 

  File -> Quit Exits the MICT. 

 

Device -> Connect Connects to the device. 

 

Device -> Disconnect Cuts the connection to the device. 

 

Device -> Download to device Downloads configuration data from the 
computer to the device. Refer to Working with 
Configurations on page 78. 

 

Device-> Upload from device Uploads configuration data from the device to 
the computer. Refer to Working with 
Configurations on page 78. 

 

Device -> Runtime data Opens the window Runtime Data. Refer to the 
section Runtime Data on page 109. 

 

Device -> Log Opens the window Log (Advanced Service 
only). Refer to the section Log on page 137. 

 

Device -> Runtime adjustments Opens the window Runtime Adjustments 
(Service and Advanced Service only). Please 
refer to the section Runtime Adjustments on 
page 138. 

 

Device -> Cylinder individual 
offsets 

Opens the window Cylinder Individual Offsets 
(Advanced Service only). Please refer to the 
chapter Cylinder Individual Offsets on 
page 144. 

  Device -> Self test Opens the window Self Test (Service and 
Advanced Service only). For this refer to 
section Self Test on page 72. 
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Symbol Menu Function 

  Device -> Pickup trace  Loads the automatically recorded pickup 
signals from the device. Refer to the section 
Pickup Trace on page 74. 

  Device-> Set spark plug operating 
hours 

Opens the window Set spark plug operating 
hours. 

  Device -> Set engine operating 
hours 

Opens the window Set Engine Operating 
Hours. 

  Device -> Set date and time Opens the window Set Date and Time, in which 
you can set the clock in the device. 

  Device -> Send command -> Reset 
misfire counters 

The misfire counters of all ignition controller 
outputs are reset and restarted. Misfires that 
previously occurred at the outputs are no 
longer displayed. 

  Device -> Send command -> 
Acknowledge operational error 

(Keyboard shortcut: Strg+R) 

All operational errors are acknowledged. This 
can only be implemented while the engine is 
not running.  

  Device -> Access Control The setup for the access control to the MIC3+ 
is described in a separate section. Please read 
the section Access Control for MIC3+ on 
page 76. 

  Device -> Temperature Extremes Opens the window Temperature Extremes in 
which the minimum and maximum 
temperatures of the controller and output 
boards are displayed. 

  Settings -> Language Opens the window Select Language in which 
you can change the interface language of the 
MICT. 

  Settings -> Online update settings Opens the window Online Update Settings. 
Refer to the section Online Update Settings on 
page 71. 

  Settings-> Database settings Opens the window Database Settings in which 
various databases can be assigned as source 
for the MICT. 

  Settings -> Temperature scale Opens the window Select Temperature Scale, 
in which you can change the unit for the 
temperatures shown in the MICT. 
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Symbol Menu Function 

  Settings -> Display by cylinders Not currently used.  

 

Document -> Schedule Curve Opens the window Schedule. Please refer to 
the chapter Schedule Curve on page 145. 

  Tools -> Coils Opens a database with information on 
MOTORTECH ignition coils. 

  Help -> Help Opens the online help function. 

  Help -> About MICT Opens detailed information on the MICT. 

  
 

8.6  Online Update Settings 
  

 

Perform regular online updates 

MOTORTECH is constantly expanding its databases. Perform regular online 
updates to make optimal use of the opportunities that the MIC3+ provides. 

  
The MICT uses data from an engine database and a coil database for the configuration. Such 
data can be updated with automatic online updates. The settings for the update can be entered 
with the following entry in the menu bar: 

Settings -> Online update settings 

 

You have the following options: 

– Enable automatic database updates 
Using the check box, you can enable and disable automatic online updates. As the default 
setting, the online update is activated and is executed daily (if an internet connection is 
established) at first start-up of the MICT. 

– Use a proxy to access the web 
Use the checkbox to activate settings for internet access via a proxy server, which you can 
then set up by entering http-Proxy and Port. 
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– Show Log 
With this button, you can open a window in which the online updates performed are logged. 

– Update Now 
With this button, you manually start an online update. 

 

8.7  Self Test 
  

 

Operational safety! 

If you carry out a self test, it is essential for the gas supply to be switched 
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons. 

  
You can run the self test via the MICT to check the order of the wiring and the connection 
between the ignition controller outputs and the spark plugs. 

Proceed in the MICT as follows: 

Device -> Self test 

 

The following information is provided: 

Status 
The status displays indicate whether the ignition controller is ready for the self test. 

– Locked 
The ignition controller is in a state in which no self test can be done. For example, there is an 
error or a configuration is currently being downloaded into the device. 
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– Active 
The self test is running. 

– Ready 
The ignition controller is ready and the self test can be started. 

You have the following options: 

– Cycles 
Determine whether the self test should run unlimited or be terminated after a defined 
number of cycles. 

– Outputs 
Define whether all outputs or only a defined output should be fired during the self test. 

– Cycle Time - All Configured Outputs 
Specify the cycle time either as a period or frequency. The value entered always refers to a 
complete cycle. That means that all outputs that are configured are fires once per cycle. If 
you only set one output for the self test, this would still only fire once per cycle. 

– Control 
Start or stop a self test using the corresponding buttons. 
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8.8  Pickup Trace 
The traces of the pickup signals support you in checking the behavior of the used pickup and 
thus, for example, to detect and analyze irregularities or failures. 

Pickup signals are automatically recorded by the ignition controller as soon as they are detected 
at the configured inputs. Ten further signals are recorded if an error occurs during operation 
(cumulative across all inputs). The recording is then stopped so that the pickup signals just 
before the error can be analyzed. The records can be downloaded from the device at any time. 

Proceed in the MICT as follows: 

Device -> Pickup trace 

  

 

Pickup trace 

Example of a pickup trace for a configuration with two pickups: 

– Pickup input 1 (cam): 
Single event from the camshaft 

– Pickup input 2 (trigger): 
Trigger disc type N-1 with 160-1 events from the crankshaft 

 

  

Operation 
The following options are available via the menu in the window: 

– Open 
Opens a previously saved pickup trace. 

– Save as 
Saves a pickup trace as a .putrace file. 

– Close 
Closes the pickup trace. 
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There are the following options for the display of the pickup signals: 

– Zoom In/Out 
Using the mouse scroll wheel you can zoom in and out of the displayed record range. 
Alternatively you can also use the plus and minus keys on the keyboard. With the zoom 
function, you can e.g. analyze the trigger signal more precisely (see figure). 

 
– Move displayed range 

With the right mouse button pressed you can move the displayed range along the time axis. 

– Measuring 
You can measure distances and the number of events in the displayed range by holding 
down the left mouse button to highlight a section. You can find the following information in 
the window: 

– Position on the time axis 

– Time difference (Δ) between the two selected points 

– Number of events counted in the selected period 

 

Error Analysis 
The pickup traces support you, for example, in analyzing the following errors: 

– Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration, 
allocation of the inputs, allocation of the shafts). In this case, you should compare the 
values configured with the signals recorded (see Engine – Pickups on page 91). 

– One or more pickups have failed. 
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Pickup trace 

The pickup signals are only recorded on the inputs that are configured in 
the MICT. No signals are recorded if the pickup input configuration is not 
valid. 

  
 

8.9  Access Control for MIC3+ 
If the access control to the MIC3+ is activated, access to the following areas is possible with a 
PIN only: 

– Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and 
secondary short calibration) 

– Commands (Alarms, error commands, set engine/spark plug operating hours, and self test). 

– Configuration (Transferring a configuration to the MIC3+) 

The access control regulates the accesses to the device via the MICT. For explanations 
concerning access control of the MIC3+ and the delimitation of the access levels in the MICT, 
refer to section Access Control on page 63. 

The access control functions can be accessed in the menu bar via: 

Device -> Access Control 
 

8.9.1 Enable/Disable Access Control 
   

 

Enable/Disable access control 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access control 
again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Reset all PINs on 
page 77. 

  

To enable or disable the access control, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Enable or Disable access control. 

2. Enter the PIN for the level Master (Level 3). 

3. Confirm the input with OK. 
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8.9.2 Login/Logout 
If the access control is activated, you are prompted to log in if you want to execute functions that 
are allocated to a specific operating level. In addition, you can log in specifically to an operating 
level via the menu bar. 

To log into a specific operating level, proceed as follows: 

1. Open the input dialog via Device-> Access Control -> Login. 

2. First select the level you wish to log on to. 

3. Enter the PIN for the desired level. 

4. Confirm the input with OK. 

▸ You are now logged into the corresponding level and can execute all functions that are 
allocated to this operating level without having to log in again. 

After completing the log-in, you can log out again as follows: 

Device -> Access Control -> Logout 
 

8.9.3 Changing the PIN 
To change the PIN for a specific operating level, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Change PIN. 

2. First select the level for which you wish to change the PIN. 

3. Enter the current PIN for the desired level. 

4. Enter the new PIN in the two subsequent fields. 

5. Confirm the input with OK. 

▸ The PIN for this operating level has now been changed. 
 

8.9.4 Reset all PINs 
To reset all PINs, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Reset all PINs. 

2. If you are not yet logged into the Master (level 3) level, you will be prompted to log in with 
the relevant PIN. 

3. Confirm the input with OK. 

4. To reset all PINs, you will be prompted again to enter the PIN for the level Master (Level 3). 

5. Confirm the input with OK. 

▸ All PINs are now reset to the value 0000. 
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To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in 
case of emergency that was locked in this way, you have the following option: 

1. In the menu bar, select the entry Device -> Access Control -> Get reset all PINs request key to 
open a window with the same name. 

2. Send the request key with the serial number to your service contact person at MOTORTECH 
(refer to Customer Service Information on page 159). This key is valid only for the respective 
controller and only for a certain amount of time. 

▸ Your information will be verified, and you will receive an authorization key from your 
contact person. 

3. From the menu bar, select the entry Device -> Access Control -> Set reset all PINs 
authorization key to open a window with this name. 

4. Enter the authorization key received in the input field. 

5. Confirm the input with OK. 

▸ If the input was correct, all PINs are reset to the default value 0000. 
 

8.10  Working with Configurations 
To ensure that the MIC3+ correctly interprets incoming data and correctly controls the ignition 
system, it requires information about the engine and the ignition system. This information is 
stored in the MIC3+ as configuration data. 

You can use the MICT to perform the following for these configurations: 

– Create 

– Open 

– Edit 

– Save as a file 

– Download to the MIC3+ 

– Upload from the MIC3+ 
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8.10.1 Create, Open, Save 

 

Click on the symbol to create a new configuration and select the corresponding 
device type. The device type corresponds to the first five digits of the 
arrangement number, which you can find on a label on your device. 

 

 

Click on the symbol to open a saved configuration. 

 

 

Click on the symbol to save the configuration currently displayed in the MICT to 
a storage device. 
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Compatibility of the configuration files 

Configuration files are only compatible for the respective device type, even 
if the file extension is identical. For example, files created for a MIC3 cannot 
be downloaded to a MIC3+ and vice versa.  

To use a configuration for another device, the series and the first four digits 
of the arrangement number must match. This information can be found in 
the title bar of the configuration and on the respective device: 

MIC3 

 

 

MIC3+ 

 

 

If, for example, a system is to be changed from a MIC3 to a MIC3+, the 
configuration of the MIC3 can be saved as a PDF file. Then a new 
configuration file must be created for the MIC3+ and the values from the 
PDF file must be entered. Alternatively, the MICT can be opened twice and 
the values transferred to a newly created configuration file. 

 

  
 

8.10.2 Upload, Download 

 

Click the symbol to upload the current configuration from the MIC3+ to the 
MICT. If applicable, the MICT first establishes a connection to the MIC3+ 
connected. 

 

Click on the symbol to download the configuration set in the MICT to the MIC3+. 
This function can only be executed while the ignition is not active. This action 
overwrites the existing configuration on the device. If applicable, the MICT first 
establishes a connection to the MIC3+ connected. 
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Existing configuration is cleared! 

If you download a configuration to a MIC3+, the previous configuration is 
deleted and the new settings are immediately implemented. 

    

 

Runtime adjustments 

If you change a configuration stored in the MIC3+ via runtime adjustments, 
the configuration must be re-uploaded from the device so that the changes 
are displayed in the MICT's configuration views. 

  
 

8.10.3 Compatibility Information 

 

If you upload a configuration from the MIC3+ to the MICT that does not correspond to the status 
of your MICT, or if you open this type of configuration in the MICT, the following situations may 
occur: 

– No values are present in the configuration for certain MICT functions. The MICT assumes the 
standard values for these functions. 

– The configuration contains function values that are not support by the MICT. 

The following situations can occur if you download a configuration from the MICT to a MIC3+ 
whose firmware does not correspond to the status of your MICT: 

– No values are present in the configuration for certain firmware functions. The firmware 
continues to use the preset values for these functions. 

– The configuration contains function values that are not support by the firmware. 

If you download a configuration into the MIC3+ and are notified of functions that are not 
supported by the MICT, you should check the MIC3+ settings. Re-upload the configuration from 
the MIC3+ to the MICT. You can then see which settings are not transmitted to the MICT. 

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the 
MIC3+ functions without restriction. 
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8.11  Configuration 
The window opens after you select the device type for a new configuration or an existing 
configuration or have uploaded one from the ignition controller. You can make changes to the 
configuration by selecting an entry from the navigation bar. The corresponding configuration 
data are then displayed in the configuration section and can be processed. The following 
sections will describe the settings and adjustments you can implement in the different areas. 

  

 

Indication of invalid entries 

An invalid selection or invalid input values are highlighted by pulsating 
warning signs on the configuration pages of the MICT. Additional 
information is provided in the status bar. 

Example: 
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8.11.1 Engine – Parameters 

 

Engine Selection 
The MICT holds an engine database with data from various manufacturers and model series. 
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields. 
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the 
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output 
configuration. 

 

You can use straight order wiring, if: 

– Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH 
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing 
order needs to be configured directly in the ignition controller. The ignition coils on the 
wiring rail are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the 
wiring rail is marked in the view Wiring. 

– Wiring of the ignition controller is done corresponding to the instructions in section Straight 
Order Wiring of the Ignition Outputs on page 52 (for example with an open wiring harness or 
via a junction box). 

The configuration of the ignition outputs is automatically adapted corresponding to your 
selection. If you want to use a different wiring, these settings must be adapted appropriately. 

If the pertinent engine is not available in the database, settings can also be entered by selecting 
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine 
Manufacturer and select the firing stroke in the column Series, then the number of cylinders, 
and the ignition offset of the engine as needed. After making your selections, the right hand 
section Engine Information will display a summary of the parameters selected. 

The summarized data are transferred to the subsequent configuration page Ignition Outputs. 
The values displayed there can only be changed by users with authorization to access the 
Advanced Service level. 
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Engine database 

MOTORTECH does not assume liability for the information in the engine 
database. Please contact MOTORTECH if discrepancies are found. 

  

New Engine Configuration 
Staff with the authorization for the Advanced Service level additionally has the option for 
entering the engine data manually, i.e., without selecting entries from the engine database. For 
this purpose, click on the New Engine Configuration button and select the engine type, number 
of cycles, and number of cylinders in the dialog box opening up. Additional information can be 
entered on the configuration page Ignition Outputs. 
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8.11.2 Engine – Cylinder Names 

 

To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you 
can individually name each cylinder. The schematic representation of the plan view of the 
selected engine supports you in this. Enter the following settings: 

– Enable Cylinder Names 
Activate the checkbox in order to assign cylinder names. In order to use this function, the 
number of cylinders must be defined. Establish the number of cylinders either by using a 
configuration from the engine database or by creating a new engine configuration via the 
corresponding button. Refer to the section Engine – Parameters on page 83. If you have 
activated the checkbox, the assigned cylinder names must also be assigned to the 
corresponding ignition outputs, before the configuration is transferred to the ignition 
controller. Otherwise there will be an error message. Refer to the section Engine – Ignition 
Outputs on page 87. 

– Bank Name 
Enter a name for the respective cylinder bank. 

– Cylinder Names 
Enter a name for the respective cylinder.  
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–  
currently not used  

– Show banks in reverse order 
currently not used  

 

8.11.3 Engine – Ignition Outputs 

  

Make adjustments to the following settings as needed: 

– Number of Outputs 
Select the number of outputs. 

– Column: Cylinder 
Select a cylinder. The displayed names are specified on the configuration page Engine – 
Cylinder Names. 

– Column: Output 
Select the number of the respective output. 

– Column: Angle 
Enter the firing angle for each output. 
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Default Application 
If you select from the engine database, the data stored for the selected configuration are 
displayed. These data can only be changed by personnel with access to the Advanced Service 
level. 

New Engine Configuration 
Selecting the number of outputs enables access to the fields for the configuration of the 
outputs. By default, the ignition outputs are distributed so that cylinder 1 of the ignition 
sequence is always allocated an ignition angle of 0°. The ignition angle for each output results 
from the addition of the ignition spacing to the respective previous output. 

  

 

Operational safety! 

Never connect more than one output to each ignition coil, as the output 
boards can otherwise be damaged. 

  
The allocation of outputs to the device's output connector contacts and the cylinders is 
determined by the wiring. The user must take the wiring into account during the configuration; it 
cannot be checked by the software. 

  

 

Interval between two ignitions 

The interval between two ignitions must be min. 1.7 ms. During the check, 
the configured overspeed is used in the calculation. 
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8.11.4 Engine – Ignition Coils 

 

Ignition Coil Type 
Select the ignition coil type from the drop-down list. (Without this selection the configuration 
cannot be downloaded to the MIC3+.) 

  

 

Only use measured ignition coils 

To operate the MIC3+, only ignition coil types measured by MOTORTECH 
may be used. All ignition coils used must correspond to the part number 
selected in the drop-down list. Different coil types must not be mixed and 
also no equivalent or replacement types may be used. 

If a coil type used is not in the drop-down list, then the MIC3+ is currently 
not used. 
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Secondary Diagnostics Enabled 
The secondary diagnosis can be deactivated and activated for ignition coils that support this 
function. If the ignition coil does not support this function, the secondary voltage estimation 
calibration and the of the secondary short calibration are not available. 

Secondary Voltage Estimation Calibration 
A correction value without units can be set for the secondary voltage estimation for every 
configured output to increase the accuracy of the secondary voltage estimation for each 
individual cylinder. This allows, for instance, different cable lengths on the engine to be 
compensated. 

The values of the secondary voltage estimation can be changed for each individual cylinder. The 
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You 
can adjust the secondary voltage estimation while the engine is running in the runtime 
adjustments (refer to Runtime Adjustments – Secondary Voltage Calibration on page 142). 

Secondary Short Detection Calibration 
The starting voltage and the secondary short detection sensitivity can be adjusted. You can 
adjust the secondary short detection in the runtime adjustments while the engine is running 
(refer to Runtime Adjustments – Secondary Short Calibration on page 143). 

Secondary Short Enable Voltage 
Set the average ignition voltage required to activate the secondary short-circuit monitoring: 

– The secondary short detection is always activated at a value of 0 kV. 

– The secondary short detection is always deactivated at a value of 65.535 kV. 

Secondary Short Sensitivity 
The permitted value range depends on the set ignition coil. 

Set the sensitivity of the short-circuit detection e.g. as follows: 

– The sensitivity is high at a value of 0.98. 

– The sensitivity is low at a value of 1.02. 
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8.11.5 Engine – Pickups 

 

  

 

Active pickups 

Check when using active pickups that the auxiliary supply voltage is 
configured for your application. 

  

Pickup Setup Information 
The settings made in the section Pickup Setup were summarized once again in the section 
Pickup Setup Information. 
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Pickup Setup 
Enter the following settings in this section: 

– Predefined Setup 
Select the pickup configuration suitable for your application from the list. The 
configurations available for selection depend on the previously entered settings. 

– Index/Reset Position 
Enter the distance between the first event after the set index/ reset marking and top dead 
center. With the button Adjust, you can enter the measured firing angle for a given nominal 
value. The system calculates the difference from these values, which is added to or 
subtracted from the index/reset position. 

– Pickup Sensitivity 
Open the pick list and select the desired sensitivity level for the pickup. This setting 
overwrites the value of the pre-trigger voltage if the latter was defined in the user-defined 
pickup setup. 

– High 
The signal processing starts at low engine speeds. This setting can result in increased 
susceptibility to failure. 

– Medium 
Default setting for MICT. This is a trade-off between start-up speed and sensitivity. 

– Low 
The signal processing does not start until high engine speeds are reached. This setting 
can result in reduced susceptibility to failure. 

– Trigger/Cam No. of Triggers 
Enter the number of events. The input Cam or Trigger is automatically selected by the MICT 
and is governed by the selection of the pre-defined pickup settings. 

– User-defined 
Staff authorized to access the Advanced Service level can, in addition to the standard 
settings access, use a manual setup option by clicking on the button User-defined. 
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– Type 
You can select the type of events that will occur on this input for each pickup input. Type 
and number of events are defined by the discs or ring gears used. If you decide not to 
use a pickup input, select the entry None from the list. You can set the following types: 
N 
Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a 
ring gear with 160 teeth (N=160). 
N+1 
Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth 
for the index signal (N=12). 
N+1 extended index range 
Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional 
tooth for the index signal (N=12). The permitted range for the index signal is expanded 
to 75 % of the tooth period. An incorrect direction of rotation of the engine cannot be 
detected by this setting. 
N-1 
Disc type N, where one event is missing, e.g. a ring gear with 160 teeth on which one 
tooth was removed (N=160). This missing event is used to determine the index signal 
N-2 
Disc type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on 
which two teeth located next to each other were removed (N=60). This missing event is 
used to determine the index signal. 
N Magnets, Single Magnet 
You will always use these two types together for a disc with magnets having opposite 
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal 
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that 
can be analyzed by a pickup. 
Single Event 
Disc that supplies a single event, e.g., a disc with one tooth or one magnet. 

– Number of Events 
Enter the number of events that occur on the pickup if more than one event is expected. 
For the types N+1 and N-1, enter the value for N and not the total number of events. With 
the type N Magnets, the number of magnets with identical polarity must be entered.  
The number of events must lie between 3 and 500. Additionally, it must be taken into 
account that the sum of the frequencies at the pickup input does not exceed the limit of 
10 kHz at the pre-set overspeed. 

– Speed 
Select whether the respective pickup will pick up the signal off the camshaft or the 
crankshaft. 
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– Active/Passive 
Select the pickup to be used from the pre-defined pick list: 
Passive 
passive pickup 
Active (low) 
active pickup with high level as quiescent level 
Active (high) 
active pickup with low level as quiescent level 

– Pre-Trigger 
Enter a value between 0.1 V and 7.5 V for each pickup to set the pickup sensitivity level. 
Signals that fall short of the set voltage will not be analyzed. A low pre-set value 
therefore results in a high sensitivity level, a high value results in a low sensitivity level. 

  

 

Pickup setup information 

The respective latest setting in the area of the pre-defined or arbitrary 
pickup settings is transferred to and displayed under Pickup Setup 
Information. 

  

Aux. Pickup Supply Voltage 
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and 
24 V is possible. 

Speed Settings 
Enter the following settings in this section: 

– Ignition Release 
Enter the release speed for the ignition at which the first ignition is to fire. The value shall 
not exceed 1/7 of the nominal speed. 

– Security Speed 
Enter the security speed. Below the value entered, the ignition can be switched on and off as 
desired. If the ignition is deactivated during operation above the set speed, the ignition 
cannot be immediately reactivated. Only when the ignition no longer reads a speed, i.e., the 
engine has come to a standstill, can the ignition be reactivated. 

– Nominal Speed 
Enter the nominal speed at which your engine is to be operated. With engines that are to be 
operated with variable speeds, the max. speed of the operating range must be entered. 

– Overspeed 
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines 
that are to be operated with variable speeds, a speed above the operating range must be 
entered.  
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– Max. Power-on Speed 
Enter the maximum permitted start speed at which the MIC3+ starts sending ignition pulses. 
A value of 6000 rpm is set as the default value: The MIC3+ can be activated at the starter 
speed and immediately send ignition pulses. 
For a value of 0 rpm the MIC3+ can only start sending ignition pulses once it has registered 
that the engine is at a standstill. 

 

8.11.6 Timing – Analog Inputs 

 

  

 

Auxiliary supply voltage 

Check with the configuration of the analog inputs, that the set auxiliary 
supply voltage corresponds to your application. 
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Analog Inputs Base Settings 
The ignition timing adjustment can be made using two analog input signals, which can be set 
within the following limits: 

– Analog current signal: 0-20 mA 

– Analog voltage signal: 0-10 V 

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also, 
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is 
classified by the ignition controller as failure (e.g. wire break). The error value configured in the 
schedule was set for the affected input. To reset the error state, a threshold will need to be 
exceeded. This threshold value is calculated as follows:  
Threshold to reset the error state ≥ 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold 

You set the analog input that will be used and which timing adjustment results from the analog 
signal for the two possible schedules. Refer to the section Timing – Schedule A/B – General on 
page 97. 

Aux. Analog Input Supply Voltage 
An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value 
between 5 V and 24 V. 
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8.11.7 Timing – Schedule A/B – General 

 

Schedule A General Settings 
The MIC3+ offers two schedules for implementing the necessary settings for the timing of the 
engine. The schedules A and B can be used for dual fuel operation, for example. The system 
switches between the schedules via the input Schedule A/B. If only one schedule is configured, 
the switch is ignored. The configuration options for schedule B are identical to those for set A.  

– Enable Schedule 
The settings are enabled or disabled by checking/unchecking the box. One schedule must 
always be activated. 

– Description 
Enter a description for the schedule (e.g. natural gas for the setting for this type of gas). 

Limits 
Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs 
will be limited to this range relative to the respective top dead center of the pertinent cylinder. 
The global timing can then not be shifted beyond this range by any adjustments. 
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Base Timing 
Enter the timing specified by the engine manufacturer. This point must be within the limits 
entered and is a static portion of the global timing. 

Analog Current Input / Analog Voltage Input 
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should 
prefer the analog current input due to its lower sensitivity to faults.  

Enter the values by which the adjustment is to be implemented for the corresponding input 
signal. An error value can be entered for the signals if a failure threshold has been defined for 
the corresponding input in the window Timing – Analog Inputs. If the signal is below the failure 
threshold, the timing is offset by the error value. The adjustment remains until the signal again 
exceeds the threshold to reset the error state (see Timing – Analog Inputs on page 95). 

Cylinder Individual Timing Limits 
Enter the maximum possible cylinder individual offset. This setting limits, among other things, 
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also 
apply to the corresponding adjustment signals from all other sources, for example via the field 
buses. 

Speed Curve 
The speed curve can be activated and disabled by mouse click and offsets the timing depending 
on the speed. A max. of eight speed points are available. If you select a number of points from 
the list, the corresponding number of fields is activated for input. 

The first speed point is always set to 0 RPM. All other timing points are assigned with the value 
by which the signal is to be offset when the respective speed is reached. For the last speed 
point, the timing of the nominal speed should be entered. Please note that the speed points 
must always be entered in ascending order. 
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8.11.8 Timing – Schedule A/B – Energy 

 

You can make different energy settings for the start phase and normal operation. 

Start Phase 
Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If 
you enter values for both criteria, both values must also be exceeded, so that the ignition 
controller classifies the start phase as ended and sets the values for normal operation. If you 
only want to use one criterion, set the other value to 0. If you do not want to define any start-up 
phase, set both values to 0. 

Enter values specific to your application for the Spark Duration, the Spark Intensity and the 
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum 
voltage expected during operation. 

Normal Operation 
If the criteria specified for the start phase are exceeded, the settings for normal operation are 
used by the ignition controller. Make the energy settings the same as for the start phase. 
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Energy Limit 
You can use the field Energy Limit to limit the output energy made available by the ignition 
controller. If the set output energy is no longer sufficient to reach the set energy values (spark 
duration, spark intensity, max. breakdown voltage), the spark duration is reduced 
correspondingly. 

  

 

Required supply voltage for energy control 

Depending on the output configuration and the energy settings, for a 
correct energy control, a higher supply voltage than the minimum 10 V DC 
sufficient for operation of the device can be necessary. If this is the case, 
the required supply voltage is displayed in a notice in the window Timing – 
Schedule A/B – Energy. 

  
 

8.11.9 Timing – Miscellaneous 

 

You can specify how fast the changes of the timing should be executed. 
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– Maximum Firing Angle Change Per Cycle 
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both 
directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment 
is larger than the given value, it is divided among several cycles. 

 

8.11.10 Inputs/Outputs – Alarms 

 

The MIC3+ ignition controllers include a total of 16 configurable alarms that can be allocated to 
the general purpose outputs. 

– Description 
You can enter any desired description for an alarm. The description is used for logging the 
alarms that have occurred in the event list in the MICT. 

– Function 
The alarms can be used depending on the following functions: 

– Unused 

– Speed above threshold / below threshold 

– Engine operating hours above threshold / below threshold 
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– Spark plug operating hours above threshold / below threshold 

– Warning active 

– Error active 

– Temperature above threshold / below threshold 

– Analog voltage input over threshold / under threshold 

– Analog current input over threshold / under threshold 

– Global ignition timing above the threshold / below the threshold 

– Supply voltage above threshold / below threshold 

– Min. spark duration above threshold / below threshold 

– Misfire rate (primary, single output) over limit 

– Misfire rate (primary, all outputs) over limit 

– Misfires per second (primary, all outputs) above threshold 

– Consecutive misfires (primary, single output) above threshold 

– Misfire rate (secondary, individual output) above threshold 

– Misfire rate (secondary, all outputs) above threshold 

– Misfires per second (secondary, all outputs) above threshold 

– Consecutive misfires (secondary, single output) over the limit 

– Threshold 
Input of desired threshold value. 

– Hysteresis 
Input of desired hysteresis value. 

– Delay 
Input of desired delay. The threshold value defined in the alarm must have been exceeded or 
not reached for a longer period than the specified time for an alarm to be triggered. If a 
corresponding value occurs for a shorter period of time, no alarm is triggered. 

– Engine Shutdown 
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered. 
The shutdown causes an operational error. Therefore the checkbox should not be checked, if 
the alarm Error active is selected. 

– Permanent – Keep output activated until alarm is acknowledged 
If this box is checked, the output remains permanently active until the alarm is 
acknowledged. If the box is not checked, the output remains active only for as long as the 
alarm is active. 

– Log Events 
If this box is checked, the event list records when the alarm occurred or when it was 
acknowledged. 
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– Outputs 
Activate the checkbox GPO1, so that the general purpose output is activated when the alarm 
is triggered. 

– GPO Settings 
Configure the general purpose output as normally closed or normally open. 

 

8.11.11 Inputs/Outputs – ASO1 (Auxiliary Synchronization Output) 

 

With the auxiliary synchronization output, freely definable impulses depending on the angle of 
the crankshaft can be generated. For the output, the user defines whether the angle will be 
absolute or based on the global timing. The output can generate between 1 and 12 impulses and 
only be assigned to one system at a time. One example of the application of the ASO output for a 
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 61. 

– No. of Points 
Select the number of impulses from the No. of Points list. Please note that the DetCon 
detonation controller devices require a single impulse with 200 μs synchronous with the 
first cylinder in the ignition sequence. You can get this setting via the button Configure for 
DetCon2/20. 
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– Angle Reference 
Select from the Angle Reference drop-down list whether the angle shall be based on the 
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter 
the trigger angle for each impulse and the length of the impulse in μs. This setting also 
determines when ASO signals are generated. For this, also read the information box ASO 
signals depending on the ignition release. 

– Mode  
Select the mode for the ASO signal. 
In the default setting Trailing Rising Edge (default), the signal is low-active. 

 
In the setting Trailing Falling Edge (inverted), the signal is high-active. 

 
* ) active edge marks the configured engine rotation angle 

  

 

Maximum impulse duration 

Please note that the duration of the impulse can be entered as max. 300 μs. 
Input of higher values will not be accepted by the system. 
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ASO signals depending on the ignition release 

The setting in the drop down list Angle Reference determines when ASO 
signals are generated: 

– Actual Angles Depending on Global Timing 
ASO pulses are only transmitted if ignition is active, indicated by the 
green status display Firing Active in the window Runtime Data – 
Overview. 

– Absolute Timing 
ASO pulses are generated independently of the ignition release as soon 
as the synchronization of the pickups is accomplished. 

   
 

8.11.12 Inputs/Outputs – Inputs 

 

 Various functions can be selected for the general purpose input GPI1: 

– Disabled 
The input GPI1 will not be used. 
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– CAN reset (1 s pulse), device reset (5 s pulse) 
This feature allows (e.g. a master control) to trigger a CAN reset and/or a device reset 
externally using a high impulse. A high impulse of 1 second leads to a reset of the CAN driver 
and a high impulse of 5 seconds leads to a device reset. 

– Warning acknowledge (< 3 s high), error and alarm acknowledge (> 3 s high),  
device reset (> 15 s high) 
This feature allows (e.g. a master control) warnings, errors, and alarms to be confirmed 
and/or device reset to be triggered externally using a high impulse. If the high impulse is 
shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than 
3 seconds, all errors and alarms will be confirmed. If the high level lasts for more than 
15 seconds, this triggers a device reset. 

 

8.11.13 Miscellaneous – Communication 
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CAN 
Clicking on the CAN checkbox enables or disables the CAN interface on the device.  

– ALL-IN-ONE (J1939)/J1939/CANopen 
Select the desired protocol, depending on whether you want to set the communication for 
the ALL-IN-ONE or for another device. For example, for a connection to the PowerView3, 
select CANopen. 

– J1939 Settings 
The J1939 source address can be assigned between 0 and 253. Note that IDs cannot be 
assigned more than once. The Address Filter can be used to set that broadcast PGNs are only 
accepted from one or two specific source addresses you have entered. If the filter is 
deactivated, the broadcast PGNs are accepted from all source addresses. 

– CANopen Settings 
The CANopen node ID can be assigned between 1 and 127. Note that IDs cannot be assigned 
more than once. 

– Baudrate 
Select the desired data transfer rate from the list. The baud rate can be defined between 
50 kbit/s and 1 Mbit/s, the recommended value being 250 kbit/s. 

RS485 
Clicking on the field RS485 enables or disables the Modbus interface on the device.  

– Baudrate 
Select the desired data transfer rate from the list. The Modbus baud rate can be defined 
between 9,600 bit/s and 115,200 bit/s, the recommended value being 19,200 bit/s. 

– Parity 
Define if a parity bit is used and if the parity is to be even or odd. 

– Stopbits 
Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no parity 
has been selected. 

– Modbus Address 
The Modbus address can be assigned between 1 and 247. Note that IDs cannot be assigned 
more than once. 

– Mode 
Define if the data are transferred in the ASCII or RTU mode. 

  

 

Setting the transfer rate 

Please note that all devices connected with a bus must be set to the same 
transfer rate. 
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Information on protocols 

Please contact your MOTORTECH contact person if you require more 
information on the CANopen®, J1939 and Modbus protocols. 

    
 

8.11.14 Miscellaneous – Information 
This configuration page can be viewed by all users, but changes can only be made with 
authorization for the Service access level. 

 

Site and Module 
In this section, enter information on the system and the module for which the configuration will 
be used. 

Service Contact 
In this section, individual contact data can be saved that can be called up and displayed via 
MICT. 
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8.12  Runtime Data 

 

Click on the symbol to open the window Runtime Data. The following sections 
will give you an overview of the data you can view on the individual tabs. 

You can print and record the runtime data. For this purpose, the following functions are at your 
disposal in the toolbar in the window: 

Symbol Function 

 

Prints the runtime data. 

 

Prints the runtime data to a PDF file. 

 

Opens the print preview. 

 

Starts the runtime data trace. 

 

Stops the runtime data trace. 

 

Acknowledges the operating errors. If an operating error is acknowledged, all 
alarms are also simultaneously acknowledged. The symbol is grayed out if no 
acknowledged error is present. 

  

 

Save runtime data locally 

You should always save runtime data on the local computer and not on a 
network drive or external storage device. Trace files can only be moved 
freely once the recording is stopped. 
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8.12.1 Runtime Data – Overview 

  

In this screen, you can find the following information: 

– Speed Indicator (analog) 

– Red pointer 
Displays the current registered speed 

– Yellow pointer 
Displays the maximum registered speed since last starting the engine 

– Green pointer 
Display of set overspeed 

– Speed Indicator (digital) 
Digitally displays the current speed 

– Global Timing Point 
Digital indication of the current global timing 
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– Operating Hours 

– Spark Plugs 
Indicates the current operating hours of the spark plugs 

– Engine 
Indication of current operating hours of the engine 

– Device State 
The status of the device is shown by the following status displays: 

  

Device status Description 

Idle The ignition is ready and waiting for pickup activity. 

Synchronizing Pickup signals are being received and analyzed. 

Firing Active The ignition is active. 

Firing Locked Pickup signals are being received and are valid, ignition is 
not released. 

Wait for Stop Pickup signals are being received, the ignition fired above 
the security speed, and the ignition release was retracted. 
The engine must now come to a standstill. 

Configuration The device is being configured. 

Self Test The self test is running (refer to Self Test on page 72). 

Start Phase The engine is in the configured start phase (refer to section 
Timing – Schedule A/B – Energy on page 99). 

Warning A warning has occurred (refer to Warnings on page 127). 

Error An error has occurred (refer to Failure on page 129). 

Alarm A configured alarm has occurred (refer to Alarms on 
page 128). 

  

– Control 

– Firing Enabled 
The green status display signals that the firing is active. 

– Schedule A/B 
The green status display shows which parameter settings are currently used. 

– GPI1 
The status display shows the status of the input signal. 

– Output 

– GPO1 
The general purpose output is switched on with the green status display. 
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– Failure 

– Analog Current Input 
The red status display signals that the set failure threshold for the input has been 
reached. If the lower limit of the signal is reached again, the status display is again 
gray. 

– Analog Voltage Input 
The red status display signals that the set failure threshold for the input has been 
reached. If the lower limit of the signal is reached again, the status display is again 
gray. 

– Ignition Output 
The red status display signals a current misfire on at least one output. With a yellow 
status display at least one misfire has occurred at one output since the last reset of the 
counter. 

– Misfire Rate 
The misfire rate is displayed for the primary side and secondary side. The misfire rate on the 
secondary side is only displayed if the secondary side diagnosis is activated (refer to 
section Engine – Ignition Coils on page 89). 

– Single Output 
Displays the misfire rate of the output for which the most misfires were registered 
during the last 32 cycles. 

– All Outputs 
Displays the misfire rate for all the ignition outputs for the past 32 cycles. 

– The number of misfires per second are calculated by the MIC3+ as follows: 
2-stroke engine: Number of currently misfiring outputs x RPM / 60 
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2 
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8.12.2 Runtime Data – Timing 

  

In this view, the system displays all values and settings in the left hand section that influence 
the timing. On the right, the current input values (e. g. potentiometer, analog current and 
voltage input), leading to the displayed timing adjustment, are displayed numerically and in bar 
charts. The value for the speed curve is shown by curve progression set in the configuration. 
Refer to the section Timing – Schedule A/B – General on page 97. The timing correction can be 
implemented for the runtime. Refer to the section Runtime Adjustments – Timing on page 140. 

In the lower range, the maximum, minimum and average of the cylinder individual offsets are 
also displayed. 
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8.12.3 Runtime Data – Ignition 

  

The following information is provided: 

– Column: Output 
Designation of the output 

– Column: Cylinder 
If cylinder names are assigned, these are displayed. 

– Column: Estimated Secondary Voltage [kV] 
Secondary voltage determined by the ignition controller of the respective output. 
The secondary voltage is used to determine deviations between the individual outputs. 
These indicate a possible problem at this output (e. g. problems in the area of the spark plug 
or the cylinder). 
If you have set the ignition coils (refer to Engine – Ignition Coils on page 89) for which a 
secondary voltage estimate does not seem possible "---" appears. 
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– Column: Misfire 
The red status display signals a current misfire at the respective output. With a yellow status 
display at least one misfire has occurred at the respective output since the last reset of the 
counter. 

The coil data version configured in the MIC3+ is displayed under the ignition runtime data. 
 

8.12.4 Runtime Data – Bank A 

  

The following information is provided: 

– Column: Output 
Designation of the output 

– Column: Cylinder 
If cylinder names are assigned, these are displayed. 

– Column: Angle 
Current output firing angle 
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– Column: Min. Spark Duration 
Minimum spark duration of the outputs 

– Column: Energy Output 
Current energy release of the output 

– Columns: Misfire 
Status display for the different types of misfires (primary, secondary, open, short circuit). In 
case of misfire, the respective status display turns red, otherwise it is gray. With a yellow 
status display misfires have occurred since the last reset of the counter.  
If you hold the pointer over the status display, an overview of the misfire counter of the 
respective output is displayed for all types of misfires. A maximum up to 255 is counted per 
type of misfire. The counter manually resets using the menu item Device-> Send command -> 
Reset misfire counters. When starting the engine and starting the self test the counters are 
automatically reset. 

You have the following options: 

– Relative/Absolute 
Select via the option, whether the firing angle should be displayed absolute or relative. 
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8.12.5 Runtime Data – States 

  

Status messages are listed in the States view. 

The following information is provided: 

– Operating Hours 
Operating hours counter reading at the time of message 

– Time 
Date and time of the message (see following information box) 

– Status Message 
Message text 
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Date and time of ignition controller 

The date and time can be individually configured for each ignition controller 
and saved in the device. The device does not adjust automatically for 
daylight savings time. Hence, deviations may occur between the device 
time and the time on the computer used to access the device. 

Correspondingly, the times indicated for the states, messages, and in the 
log reflect the time of the ignition controller. The current time of the ignition 
controller is shown in the view Runtime Data – Information. You can adjust 
the time of the ignition controller by entering the desired time in the menu 
via Device -> Set date and time. 

  
Status messages are displayed in black if they are current. If a status is reset, the status 
message is displayed gray for 10 seconds before it is deleted from the list. 

The following status messages can be displayed: 

Status message Description 

Alarm shutdown caused by alarm 
number. 

The engine was shut down by an alarm, as the configured 
limit was exceeded or not reached. You can view the 
alarm number in the configuration (see Inputs/Outputs – 
Alarms on page 101). 

Analog current input failure 
(current: x mA, failure threshold: 
y mA, failure reset threshold: 
z mA). 

Failure threshold set for analog current input was 
undershot (see Timing – Analog Inputs on page 95).  
The following values were obtained: Current: x mA, failure 
threshold: y mA, threshold for failure reset: z mA. 

Analog voltage input failure 
(voltage: x V, failure threshold: 
y V, failure reset threshold: z V). 

Failure threshold set for analog voltage input was 
undershot (see Timing – Analog Inputs on page 95).  
The following values were obtained: Voltage: x V, failure 
threshold: y V, threshold for failure reset: z V. 

Aux analog input supply voltage 
failure (voltage: u V, desired 
voltage: v V, failure threshold: x V, 
failure reset threshold: y V). 

Error in auxiliary supply voltage of analog inputs (see 
Timing – Analog Inputs on page 95). The following values 
were obtained: Voltage: u V, expected voltage: v V, failure 
threshold: x V, threshold for failure reset: y V 

Aux pickup supply voltage failure 
(voltage: u V, desired voltage: v V, 
failure threshold: x V, failure reset 
threshold: y V). 

Error in auxiliary supply voltage of pickup (see Engine – 
Pickups on page 91). The following values were obtained: 
Voltage: u V, expected voltage: v V, failure threshold: x V, 
threshold for failure reset: y V 

Configuration data checksum 
error. Using default configuration. 

The checksum of the configuration data is faulty. The 
default configuration is used. This message may appear 
during an upgrade/downgrade. Check your configuration 
data and the MICT version being used. Then download the 
configuration to the device once again. 
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Status message Description 

Configuration invalid. Using 
previous configuration. 

The configuration is invalid. The previous configuration is 
used. This message may appear during an 
upgrade/downgrade. Check your configuration data and 
the MICT version being used. Then download the 
configuration to the device once again. 

Current sensor of output bank 
name failed. 

The current sensor of output bank name failed. Restart 
the ignition controller. If the error occurs again after 
restarting the device, please contact MOTORTECH. 

Cylinder individual timing limited 
to range timing 1 .. timing 2 

The cylinder-individual offset has reached the set limit 
(Timing 1 ... Timing 2 (see Timing – Schedule A/B – 
General on page 97). 

Device started after supply 
voltage failure. 

The device was started after a failure of the supply 
voltage. Please check the power supply of the device 
where applicable. 

General error number. General error number. Restart the ignition controller. If 
the error occurs again after restarting the device, please 
contact MOTORTECH. 

Global timing x° crankshaft limited 
to range y° crankshaft .. z° 
crankshaft. 

The global timing (x° crankshaft) is located outside the 
configured limits (y° crankshaft .. z° crankshaft; see 
Timing – Schedule A/B – General on page 97). 

Incompatible coil parameters 
received, secondary voltage 
diagnostics disabled. 

Incompatible coil parameters received. The secondary 
voltage diagnostics have been disabled. This message 
may appear during an upgrade/downgrade. Check your 
configuration data and the MICT version being used. Then 
download the configuration to the device once again. 

Output board identification failed 
due to a checksum error. 

The identification of the output board failed due to a 
checksum error. Restart the ignition controller. If the error 
occurs again after restarting the device, please contact 
MOTORTECH. 

Output board identification failed 
due to incompatible hardware. 

The identification of the output board failed due to 
incompatible hardware. Restart the ignition controller. If 
the error occurs again after restarting the device, please 
contact MOTORTECH. 

Output board identification failed 
due to missing data. 

The identification of the output board failed due to 
missing data. Restart the ignition controller. If the error 
occurs again after restarting the device, please contact 
MOTORTECH. 
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Status message Description 

Output board identification failed 
due to unknown error number. 

The identification of the output board failed due to 
unknown error number. Characteristic data of the output 
board could not be read, they are defective or do not 
match the device. Restart the ignition controller. If the 
error occurs again after restarting the device, please 
contact MOTORTECH. 

Output board identification failed 
due to unknown hardware. 

The identification of the output board failed due to 
unknown hardware. Characteristic data of the output 
board could not be read, they are defective or do not 
match the device. Restart the ignition controller. If the 
error occurs again after restarting the device, please 
contact MOTORTECH. 

Pickup configuration invalid. The pickup configuration is invalid. This message may 
appear during an upgrade/downgrade. Check your 
configuration data and the MICT version being used. Then 
download the configuration to the device once again. 

Power failure detected on output 
Anumber. 

Power supply fault in output board at output Anumber 
was detected. Restart the ignition controller. If the error 
occurs again after restarting the device, please contact 
MOTORTECH. 

Power output (x W) exceeded error 
threshold limit (y W) at a supply 
voltage of z V. 

The power output (x W) exceeded failure threshold (y W) at 
a supply voltage of z V. Increase the supply voltage and 
check the energy settings (see Timing – Schedule A/B – 
Energy on page 99). 

Power output (x W) exceeded limit 
(y W) at a supply voltage of z V. 

The power output (x W) exceeded warning threshold limit 
(y W) for longer than two minutes at a supply voltage of 
z V . Increase the supply voltage and check the energy 
settings (see Timing – Schedule A/B – Energy on page 
99). 

The power output (x W) exceeded 
permanent limit (y W) at a supply 
voltage of z V. 

The power output (x W) exceeded warning threshold limit 
(y W) for longer than three minutes at a supply voltage of 
z V . Increase the supply voltage and check the energy 
settings (see Timing – Schedule A/B – Energy on page 
99). 

PUnumber: Faulty index. The pickup PUnumber has an error in index. Check the 
pickups and the corresponding configuration (see Engine 
– Pickups on page 91). Furthermore, also pay attention to 
the instructions in the section entitled Pickup Input Errors 
on page 158. 
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Status message Description 

PUnumber: Faulty Signal. Signal 
period (x, events counted y) is too 
small compared to previous signal 
period (z). 

The pickup (PUnumber) is supplying a faulty signal. 
Signal period (x, events counted y) is too small compared 
to previous signal period (z). Check the pickups and the 
corresponding configuration (see Engine – Pickups on 
page 91). Furthermore, also pay attention to the 
instructions in the section entitled Pickup Input Errors on 
page 158. 

PUnumber: Index mark missing. Index mark missing for pickup (PUnumber). Check the 
pickups and the corresponding configuration (see Engine 
– Pickups on page 91). Furthermore, also pay attention to 
the instructions in the section entitled Pickup Input Errors 
on page 158. 

PUnumber: Missing index. Index missing for pickup (PUnumber). Check the pickups 
and the corresponding configuration (see Engine – 
Pickups on page 91). Furthermore, also pay attention to 
the instructions in the section entitled Pickup Input Errors 
on page 158. 

PUnumber: Missing Signal. Signal 
period (x, events counted y) is too 
great compared to previous signal 
period (z). 

Signal missing for pickup (PUnumber). Signal period (x, 
events counted y) is too large compared to previous 
signal period (z). Check the pickups and the 
corresponding configuration (see Engine – Pickups on 
page 91). Furthermore, also pay attention to the 
instructions in the section entitled Pickup Input Errors on 
page 158. 

PUnumber: Missing Signal. Signal 
timeout occurred (events counted 
x). 

Signal missing for pickup (PUnumber). Timeout occurred 
(events counted until timeout x). Check the pickups and 
the corresponding configuration (see Engine – Pickups on 
page 91). Furthermore, also pay attention to the 
instructions in the section entitled Pickup Input Errors on 
page 158. 

PUnumber: No index mark found. Could not find index mark for pickup (PUnumber). Check 
the pickups and the corresponding configuration (see 
Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 

PUnumber: No signal. The pickup (PUnumber) is not supplying a signal. Check 
the pickups and the corresponding configuration (see 
Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 
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Status message Description 

PUnumber: Number of events (x) 
counted on pickup input 
PUnumber does not the match the 
expected value (y). 

For the pickup (PUnumber) the number of events (x) 
counted on pickup input number does not the match the 
expected value (y). Check the pickups and the 
corresponding configuration (see Engine – Pickups on 
page 91). Furthermore, also pay attention to the 
instructions in the section entitled Pickup Input Errors on 
page 158. 

PUnumber: Operational error. An operational error occurred at pickup (PUnumber). 
Check the pickups and the corresponding configuration 
(see Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 

PUnumber: Polarity detection 
failed. 

Polarity detection failed for pickup (PUnumber). Check 
the pickups and the corresponding configuration (see 
Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 

PUnumber: Synchronization 
problem. 

A synchronization error occurred at pickup (PUnumber). 
Check the pickups and the corresponding configuration 
(see Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 

PUnumber: Wrong pickup signal 
polarity on pickup input 
PUnumber detected. Reversing 
polarity internally. 

Wrong polarity of pickup (PUnumber) detected at pickup 
input PUnumber. Reversing polarity internally. No 
additional action required. 

Self test aborted because pickup 
signals have been detected on 
pickup input PUnumber. 

Self test aborted because pickup signals have been 
detected on pickup input PUnumber. Self test can only be 
carried out when engine is at a standstill (see Self Test on 
page 72).  
Potential causes: 

– Interference coupling on pickup signal 

– Engine was started 

Speed (x RPM) exceeded 
overspeed limit (y RPM) at trigger 
signal number. 

The speed (x RPM) exceeded overspeed limit (y RPM) at 
trigger signal number (see Engine – Pickups on page 91). 
The reason for this may also be an interference coupling 
on the trigger signal. 

Temperature of device (x °C) 
exceeded error threshold limit 
(y °C). 

The temperature of the device (x °C) exceeded failure 
threshold (y °C). Ensure that there is sufficient air 
circulation and/or cooling. 
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Status message Description 

Temperature of device (x °C) 
exceeded limit (y °C). 

The temperature of the device (x °C) exceeded warning 
threshold limit (y °C) for more than two minutes. Ensure 
that there is sufficient air circulation and/or cooling. 

Temperature of device (x °C) 
exceeded permanent limit (y °C). 

The temperature of the device (x °C) exceeded warning 
threshold limit (y °C)  for more than ten minutes. Ensure 
that there is sufficient air circulation and/or cooling. 

Temperature sensor failed. The temperature sensor has failed. Restart the ignition 
controller. If the error occurs again after restarting the 
device, please contact MOTORTECH. 

  
 

8.12.6 Runtime Data – Message Log 

  

In the view Message Log, information, warnings, errors and alarms are listed. 
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Information, warnings and errors are specified by the ignition controller, while alarms can be 
freely configured using the MICT. Refer to the section Inputs/Outputs – Alarms on page 101. 

Errors and appropriately configured alarms shut down the engine. 

The following information is provided: 

– Operating Hours 
Operating hours counter reading at the time of message 

– Time 
Date and time of the message (see following information box) 

– Category 
Type of message (information, warning, error, alarm) 

– Message 
Message text; you can find more information on the message text in the following sections. 

You have the following options: 

– Automatic scrolling 
If this box is checked, the system automatically displays the last list entry until a new event 
occurs. 

– Acknowledge Alarms 
With this button, you can reset triggered alarms if they are no longer active. An alarm can 
only be acknowledged if the checkbox Permanent – Keep output activated until alarm is 
acknowledged in the alarm configuration is activated.  

  

 

Date and time of ignition controller 

The date and time can be individually configured for each ignition controller 
and saved in the device. The device does not adjust automatically for 
daylight savings time. Hence, deviations may occur between the device 
time and the time on the computer used to access the device. 

Correspondingly, the times indicated for the states, messages, and in the 
log reflect the time of the ignition controller. The current time of the ignition 
controller is shown in the view Runtime Data – Information. You can adjust 
the time of the ignition controller by entering the desired time in the menu 
via Device -> Set date and time. 
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Acknowledging an operating error 

While the engine is in standstill, there are the following options for 
acknowledging operating errors: 

– via Device -> Send command -> Acknowledge operational error in the 
MICT 

– Restart / Reset 

         
 

8.12.6.1 Information 
Information Description 

Access control disabled. The Access control was disabled (see Access Control for 
MIC3+ on page 76). 

Access control enabled. The Access control was enabled (see Access Control for 
MIC3+ on page 76). 

All access control PINs reset. All PINs for access control were reset (see Access Control 
for MIC3+ on page 76). 

CAN interface CANnumber entered 
bus off state. 

The CAN interface CANnumber has entered Bus off state 
(see Runtime Data – Diagnostics on page 133). 

CAN interface CANnumber left bus 
off state. 

The CAN interface CANnumber has left the Bus off state 
(see Runtime Data – Diagnostics on page 133). 

CAN reset requested by 
GPInumber. 

A CAN reset was requested via general purpose input 
GPInumber (see Inputs/Outputs – Inputs on page 105). 

CANopen on interface CANnumber 
changed state to "name". 

The CANopen at interface CANnumber has changed state 
to "name" (state of NMT State Machine according to CiA 
DS 301). 

Configuration changed. The Configuration of device was changed (via the MICT or 
via fieldbus). 

Date and time set. The date and the time have been set. 

Device (firmware 
number.number.number.number) 
started at a supply voltage of x V. 

The device (firmware number.number.number.number) 
was started with a supply voltage of x V. 

Device reset requested by 
GPInumber failed because pickup 
signals have been detected. 

The device reset requested by GPInumber failed because 
pickup signals have been detected (see Inputs/Outputs – 
Inputs on page 105). 

Device switched off. The device was switched off. 

Engine operating hours set to x h. The engine operating hours set to x h. 
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Information Description 

Failed to change PIN of access 
control level "number". 

Failed to change PIN of access control level "number" (see 
Access Control for MIC3+ on page 76). 

Failed to disable access control. The access control could not be disabled (see Access 
Control for MIC3+ on page 76). 

Failed to enable access control. The access control could not be enabled (see Access 
Control for MIC3+ on page 76). 

Failed to reset all access control 
PINs. 

Failed to reset all PINs for access control (see Access 
Control for MIC3+ on page 76). 

Firing disabled (Start/Stop In: 
value, CAN: value, RS485: value) 

The firing is disabled, because at least one of the inputs 
(start/stop input, CAN interface, RS485 interface) used for 
the firing release is disabled. The inputs can have the 
following values: 

– enabled: Firing enabled 

– disabled: Firing disabled 

– n/a: not used 

Firing enabled (Start/Stop In: 
value, CAN: value, RS485: value) 

The firing is enabled, because all inputs (start/stop input, 
CAN interface, RS485 interface) used for the firing release 
are enabled. The inputs can have the following values: 

– enabled: Firing enabled 

– disabled: Firing disabled 

– n/a: not used 

J1939 on interface CANnumber 
changed state to "name". 

J1939 on interface CANnumber changed state to "name". 
Following statuses are possible: 

– Enter/Start succeeded 
The CAN mode J1939 or ALL-IN-ONE (J1939) was 
started. 

– Start failed 
Initialization failed. 

– Stop 
Assignment of the Source Address was unsuccessful. 
A different source address needs to be set in the 
configuration (see Miscellaneous – Communication 
on page 106). 

– Leave 
Left CAN mode J1939 or ALL-IN-ONE (J1939). 
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Information Description 

One or more messages are lost 
due to exhausted memory pool or 
message queue overrun. 

One or more messages were lost because there was 
insufficient storage space or too many messages were 
queued. 

Operational error acknowledged. Operational errors are acknowledged. 

PIN of access control level 
"number" changed. 

PIN of access control level "number" changed (see Access 
Control for MIC3+ on page 76).  

Self test denied because no 
outputs are configured. 

The self test could not be carried out because no outputs 
are configured (see Self Test on page 72). 

Self test started. The self test was started (see Self Test on page 72). 

Self test stopped. The self test was stopped (see Self Test on page 72). 

Spark plug operating hours set to 
x h. 

The spark plug operating hours were set to x h. 

Speed (x RPM) exceeded maximum 
allowed speed (yRPM) at power-
on. Waiting for engine stop. 

Speed (x RPM) has exceeded the maximum speed (y RPM) 
during operation. The ignition controller is waiting for the 
engine to stop. 

Wrong pickup signal polarity on 
pickup input PUnumber detected. 
Reversing polarity internally. 

Wrong pickup polarity detected at pickup input 
PUnumber. Reversing polarity internally. 

  
 

8.12.6.2 Warnings 
Contrary to errors, warnings do not result in the engine being shut down. 

Warning Description 

Configuration data checksum 
error. Using default configuration. 

The checksum of the configuration data is faulty. The 
default configuration is used. This message may appear 
during an upgrade/downgrade of the firmware. Check 
your configuration data and the MICT version being used. 
Then download the configuration to the device once 
again. 

Configuration invalid. Using 
previous configuration. 

The configuration is invalid. The previous configuration is 
used. This message may appear during an 
upgrade/downgrade. Check your configuration data and 
the MICT version being used. Then download the 
configuration to the device once again. 

Disable secondary diagnostic due 
to output Anumber. 

Secondary diagnosis disabled due to output Anumber 
shut off. Check the ignition coil and wiring at the 
corresponding output. 
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Warning Description 

General warning number. General warning number. An undefined warning has 
occurred. If this occurs repeatedly, please contact 
MOTORTECH. 

Incompatible coil parameters 
received, secondary voltage 
diagnostics disabled. 

Incompatible coil parameters received. The secondary 
voltage diagnostics have been disabled. This message 
may appear during an upgrade/downgrade. Check your 
configuration data and the MICT version being used. Then 
download the configuration to the device once again. 

Invalid coil data received. Invalid coil data received. This message may appear 
during an upgrade/downgrade. Check your configuration 
data and the MICT version being used. Then download the 
configuration to the device once again. 

Pickup configuration invalid. The pickup configuration is invalid. This message may 
appear during an upgrade/downgrade. Check your 
configuration data and the MICT version being used. Then 
download the configuration to the device once again. 

Power output (x W) exceeded limit 
(y W) at a supply voltage of z V. 

The power output (x W) exceeded warning threshold limit 
(y W) for longer than two minutes at a supply voltage of 
z V . 

Speed (x RPM) exceeded 
overspeed limit (y RPM). Previous 
speed was z RPM. 

Speed (x RPM) exceeded overspeed limit (y RPM). 
Previous speed was z RPM (see Engine – Pickups on page 
91). The reason for this may also be an interference 
coupling on the trigger signal. 

Temperature of device (x °C) 
exceeded limit (y °C) 

The temperature of the device (x °C) exceeded warning 
threshold limit (y °C) for more than two minutes. Ensure 
that there is sufficient air circulation and/or cooling. 

  
 

8.12.6.3 Alarms 
Alarms can be defined in the configuration. When doing so, each alarm is assigned a number 
(see Inputs/Outputs – Alarms on page 101). 

Alarm Description 

Alarm number  "description" 
acknowledged. 

The alarm number  "description" was acknowledged. 

Alarm number  "description" 
triggered. 

The alarm number  "description" was triggered. 

All alarms reset. All alarms reset. 
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8.12.6.4 Failure 
All system or operational errors cause the engine to be shut down. 

Error Description 

Alarm shutdown caused by alarm 
number. 

The engine was shut down by alarm number. This 
function was defined in the configuration (see 
Inputs/Outputs – Alarms on page 101). 

Assertion failed (x). An assertion was not adhered to (x). For example, an 
assumption for a value was not fulfilled in the firmware. If 
the error occurs again after restarting the device, please 
contact MOTORTECH. 

Critical error x (y). Critical error x (y). If the error occurs again after restarting 
the device, please contact MOTORTECH. 

Current sensor of output bank 
name failed. 

The current sensor of output bank name failed. Restart 
the ignition controller. If the error occurs again after 
restarting the device, please contact MOTORTECH. 

Cycle signal was missing, so more 
trigger signals were counted than 
available per cycle. 

Cycle signal was missing, so more trigger signals were 
counted than available per cycle. Check the pickups and 
the corresponding configuration (see Engine – Pickups on 
page 91). Furthermore, also pay attention to the 
instructions in the section entitled Pickup Input Errors on 
page 158. 

Device started after supply voltage 
failure. 

The device was started after a failure of the supply 
voltage. Please check the power supply of the device 
where applicable. 

General error number. General error number. An undefined error has occurred. 
Restart the ignition controller. If the error occurs again 
after restarting the device, please contact MOTORTECH. 

General error in pickup pre-
processing on pickup input 
PUnumber. 

General error in pickup pre-processing on pickup input 
PUnumber. Check the pickups and the corresponding 
configuration (see Engine – Pickups on page 91). 
Furthermore, also pay attention to the instructions in the 
section entitled Pickup Input Errors on page 158. 

Number of trigger signals 
(number) counted does not match 
the configured value. 

Number of trigger signals (number) counted does not 
match the configured value. Check the pickups and the 
corresponding configuration (see Engine – Pickups on 
page 91). Furthermore, also pay attention to the 
instructions in the section entitled Pickup Input Errors on 
page 158. 
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Error Description 

Operational error caused by 
pickup signals. PU1 = x, PU2 = y. 

An operational error was caused by pickup signals 
(pickup PU1 = x, pickup PU2 = y). 

For information on the numbers shown, please consult 
the documentation on the pickup status bits on the 
storage device enclosed with the ignition controller. You 
can open the file via the menu: Documentation -> More 
information. 

Check the pickups and the corresponding configuration 
(see Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 

Output board identification failed 
due to a checksum error. 

The identification of the output board failed due to a 
checksum error. Restart the ignition controller. If the error 
occurs again after restarting the device, please contact 
MOTORTECH. 

Output board identification failed 
due to incompatible hardware. 

The identification of the output board failed due to 
incompatible hardware. Restart the ignition controller. If 
the error occurs again after restarting the device, please 
contact MOTORTECH. 

Output board identification failed 
due to missing data. 

The identification of the output board failed due to 
missing data. Restart the ignition controller. If the error 
occurs again after restarting the device, please contact 
MOTORTECH. 

Output board identification failed 
due to unknown error number. 

The identification of the output board failed due to 
unknown error number. Characteristic data of the output 
board could not be read, they are defective or do not 
match the device. Restart the ignition controller. If the 
error occurs again after restarting the device, please 
contact MOTORTECH. 

Output board identification failed 
due to unknown hardware. 

The identification of the output board failed due to 
unknown hardware. Characteristic data of the output 
board could not be read, they are defective or do not 
match the device. Restart the ignition controller. If the 
error occurs again after restarting the device, please 
contact MOTORTECH. 

Power failure detected on output 
Anumber. 

Power supply fault in output board caused by output 
Anumber was detected. Restart the ignition controller. If 
the error occurs again after restarting the device, please 
contact MOTORTECH. 
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Error Description 

Power output (x W) exceeded error 
threshold limit (y W) at a supply 
voltage of z V. 

The power output (x W) exceeded failure threshold (y W) 
at a supply voltage of z V. 

Power output (x W) exceeded 
permanent limit (y W) at a supply 
voltage of z V. 

The power output (x W) exceeded warning threshold limit 
(y W) for longer than three minutes at a supply voltage of 
z V . 

Self test aborted because pickup 
signals have been detected on 
pickup input PUnumber. 

Self test aborted because pickup signals have been 
detected on pickup input PUnumber. Self test can only be 
carried out when engine is at a standstill (see Self Test on 
page 72).  
Potential causes: 

– Interference coupling on pickup signal 

– Engine was started 

Speed (x RPM) exceeded 
overspeed limit (y RPM) at trigger 
signal number. 

The speed (x RPM) exceeded overspeed limit (y RPM) at 
trigger signal number (see Engine – Pickups on page 91). 
The reason for this may also be an interference coupling 
on the trigger signal. 

Supply voltage failure. Supply voltage failure. Please check the power supply of 
the device where applicable. 

Temperature of controller board 
(x °C) exceeded limit (y °C). 

The temperature of controller board (x °C) exceeded limit 
(y° C). Ensure that there is sufficient air circulation and/or 
cooling. 

Temperature of device (x °C) 
exceeded error threshold limit 
(y °C). 

The temperature of the device (x °C) exceeded failure 
threshold (y °C). Ensure that there is sufficient air 
circulation and/or cooling. 

Temperature of device (x °C) 
exceeded permanent limit (y °C). 

The temperature of the device (x °C) exceeded warning 
threshold limit (y °C)  for more than two minutes. Ensure 
that there is sufficient air circulation and/or cooling. 

Temperature of output board (x °C) 
exceeded limit (y °C). 

The temperature of output board (x °C) exceeded limit 
(y °C). Ensure that there is sufficient air circulation and/or 
cooling. 

Temperature sensor of controller 
board failed. 

The temperature sensor of controller board failed. Restart 
the ignition controller. If the error occurs again after 
restarting the device, please contact MOTORTECH. 

Temperature sensor of output 
board failed. 

The temperature sensor of output board failed. Restart 
the ignition controller. If the error occurs again after 
restarting the device, please contact MOTORTECH. 
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Error Description 

Trigger period (x, triggers counted 
y) is not in acceptable range 
compared to previous trigger 
period (z). 

The trigger period (x, triggers counted y) is not in 
acceptable range compared to previous trigger period (z). 
Check the pickups and the corresponding configuration 
(see Engine – Pickups on page 91). Furthermore, also pay 
attention to the instructions in the section entitled Pickup 
Input Errors on page 158. 

Trigger signal missing. Current 
trigger period (triggers counted x) 
is out of the specified range 
related to the previous trigger 
period. 

The trigger signal is missing. Current trigger period 
(triggers counted x) is out of the specified range 
compared to the previous trigger period. Check the 
pickups and the corresponding configuration (see Engine 
– Pickups on page 91). Furthermore, also pay attention to 
the instructions in the section entitled Pickup Input Errors 
on page 158. 
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8.12.7 Runtime Data – Diagnostics 

  

The following information is provided: 

– CAN State 
The status display indicates the current error handling status of the device for the CAN bus 
communication: 

– Error Active 
The device is in normal status of the bus communication. If an error occurs in the 
communication, the device sends an active error flag. 

– Error Passive 
After a defined number of errors in the bus communication, the device changes to the 
status Error Passive. If another error occurs, the device sends a passive error flag. 

– Bus Off 
The device is disconnected from the CAN bus due to error accumulations in the bus 
communication. 
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– Voltages 

– Supply Voltage 
Current voltage supply of the controller board. 

– Pickup Input Pre-Trigger Voltage  
Current pre-trigger voltage for the pickup inputs (refer to Engine – Pickups on page 91). 
During operation the pre-trigger voltage for passive pickups is increased depending on 
the speed, so that the ignition controller is less prone to interferences. 

– Aux. Pickup Supply Voltage 
Current auxiliary supply voltage of the pickups (refer to Engine – Pickups on page 91) 

– Aux. Analog Input Supply Voltage 
Current auxiliary supply voltage of the analog inputs (refer to Timing – Analog Inputs on 
page 95) 

– Power 

– Power Output 
Current output  
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8.12.8 Runtime Data – Temperatures 

  

In the window you receive an overview of the temperatures of the controller board. The maximum 
and minimum values are reset at each new start of the ignition controller. 

The following information is provided: 

– Controller Board 

– Current Temp. 
Current temperature of the controller board 

– Min. Temp. 
Minimum measured temperature of the controller board 

– Max. Temp. 
Maximum measured temperature of the controller board 
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8.12.9 Runtime Data – Information 

  

In this view, you can find an overview of the device and version data. If problems arise, you can 
print the current runtime data and send them to the MOTORTECH Service Department by fax or as 
a PDF file by email. For fast support, we will then immediately have all required information. 
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8.13  Log 

 

Click on the symbol to open the window Log. This window is only available to 
users with authorizations starting at the access level Advanced Service. 

  

The window Log serves to support error diagnostics by MOTORTECH. 

– Automatic scrolling 
If the function is active, the view panel focuses on the latest message. 

– Log level 
The selection of the log level is specified by MOTORTECH if needed. 

– Write log to file 
This checkbox activates or deactivates, respectively, the saving of the logged data in a 
selected file. If the function is disabled, the logged data are merely shown on the display. 

– Select file 
With this button, you can select a file to which you want to save the logged data. 
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If you are prompted to create a log file in the case of a service request, proceed as follows: 

1. Open the window Log via the toolbar or the menu bar. 

2. Select a path with the Select file button and enter the file name for the log file. 

▸ If the file does not yet exist, it is automatically created with the extension .log. 

3. Activate the checkbox Write log to file. 

4. Select the level specified by MOTORTECH from the list Log level. 

5. Leave the window open. 

▸ The log messages are logged both in the window and in the selected file. 

  

 

Date and time of ignition controller 

The date and time can be individually configured for each ignition controller 
and saved in the device. The device does not adjust automatically for 
daylight savings time. Hence, deviations may occur between the device 
time and the time on the computer used to access the device. 

Correspondingly, the times indicated for the states, messages, and in the 
log reflect the time of the ignition controller. The current time of the ignition 
controller is shown in the view Runtime Data – Information. You can adjust 
the time of the ignition controller by entering the desired time in the menu 
via Device -> Set date and time. 

  
 

8.14  Runtime Adjustments 

 

Click on the symbol to open the window Runtime Adjustments. This window is 
only available to users with authorizations starting with access level Service. 

  

 

Runtime adjustments are implemented directly 

All runtime adjustments are implemented directly without requiring the 
input to be confirmed and are retained even in the case of a MIC3+ restart. 
Changes that have been saved in the device configuration are only 
displayed after re-uploading the device configuration in the MICT's main 
window. 
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8.14.1 Runtime Adjustments – Reset 

  

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device 
is being operated. The correction is made with the buttons: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

Changes are implemented immediately and stored in the configuration provided in the device. 

If the correction range is not sufficient, the reset/index position must be adjusted in the 
configuration (refer to Engine – Pickups on page 91). 
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8.14.2 Runtime Adjustments – Timing 

  

The global ignition timing position can be corrected by 50 °crankshaft (advanced/retarded) 
while the device is being operated. The correction is made with the buttons: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The limit for the ignition timing set in the schedule (refer to Timing – Schedule A/B – General on 
page 97) cannot be exceeded or not reached with the runtime adjustment. 

The correction of the global ignition timing is immediately implemented and also remains in 
place if the device is restarted. NOTICE: The configuration defined in the device is not changed. 
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8.14.3 Runtime Adjustments – Energy 

  

The energy settings can be separately adjusted for both schedules. Changes are implemented 
immediately and stored in the configuration provided in the device. 

Spark Duration 
– +/- 1 μs 

lengthen or shorten in microsecond increments 

– +/- 10 μs 
lengthen or shorten in 10 μs increments 

Spark Intensity 
– +/- 1 mA 

increase and decrease in milliampere increments 

– +/- 10 mA 
increase or reduce in 10 mA increments 
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8.14.4 Runtime Adjustments – Secondary Voltage Calibration 

  

The secondary voltage estimation can be calibrated in this window when using ignition coils that 
support this function: 

A correction value without units can be set for the secondary voltage estimation for every output 
to increase the accuracy of the secondary voltage estimation for each individual cylinder. This 
allows, for instance, different cable lengths on the engine to be compensated. 

The secondary voltage estimation should be calibrated under full load at a nominal speed. The 
adjustment can be made using the relevant global or individual cylinder buttons. The value 
range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders. 

Changes are implemented immediately and stored in the configuration provided in the device. 
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8.14.5 Runtime Adjustments – Secondary Short Calibration 

  

The starting voltage and sensitivity for the secondary short-circuit detection can be adjusted. 

Changes are implemented immediately and stored in the configuration provided in the device. 

Secondary Short Enable Voltage [kV] 
Set the necessary average ignition voltage required to activate the secondary short-circuit 
monitoring: 

– The secondary short detection is always activated at a value of 0 kV. 

– The secondary short detection is always deactivated at a value of 65.535 kV. 

Secondary Short Sensitivity 
The permitted value range depends on the set ignition coil. 

Set the sensitivity of the short-circuit detection e.g. as follows: 

– The sensitivity is high at a value of 0.98. 

– The sensitivity is low at a value of 1.02. 

  

 

Adjust the sensitivity of the short-circuit monitoring 

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity 
must be set to 1.02. 

If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity must 
be set to 0.98. 
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8.15  Cylinder Individual Offsets 

 

Click on the symbol to open the window Cylinder Individual Offsets. This 
window is only available to users with authorizations starting with access level 
Service. 

  

The cylinder individual offset can be applied to the position of the timing point while the 
controller is being operated. Offset via keys: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The adjustment option of this function is limited by the specified settings in the configuration. 
Refer to the section Timing – Schedule A/B – General on page 97. 

  

 

Immediate execution of the changes 

Please note that changes made to the timing point are executed 
immediately at the next firing of the corresponding cylinder. The maximum 
performed change per cycle is however limited by the corresponding setting 
in the configuration. For this read Timing – Miscellaneous on page 100. 

   

 

Save changes automatically 

Please remember that changes to the ignition timing are saved 
automatically. 
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8.16  Schedule Curve 

 

Click on the symbol to open the window Schedule. 

  
 

8.16.1 Schedule Curve – Simulation 

 

The schedule curve visualizes the configurations of the schedules and simulates the influence of 
the inputs over the speed range. With the optional input fields, you can switch between 
schedule A and B. Changes made by turning the control buttons or entering the desired values 
are displayed simultaneously. 

– Simulation 
The simulation is activated or disabled using the checkbox. 

– Potentiometer 
Simulation of the potentiometer 

– Control button for adjustments between 0 % and 100 % 

– Field for manual input of the desired value in % 

– Displays the value in °crankshaft by which the timing is offset 
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– Analog Current Input 
Simulation of the analog current input 

– Control button for adjustments between the configured values (e.g. 0 mA and 20 mA) 

– Field for manual input of the desired value in mA 

– Displays the value in °crankshaft by which the timing is offset 

– Analog Voltage Input 
Simulation of the analog voltage input 

– Control button for adjustments between the configured values (e.g. 0 V and 10 V) 

– Field for manual input of the desired value in V 

– Displays the value in °crankshaft by which the timing is offset 

– Schedule A/B 
Select between Schedule A and B 

– Timing Point 
Displays the global ignition timing as it changes during the simulation. 

While connected to the device, the ignition timing is simulated depending on the actual engine 
speed and marked as  in the diagram. 
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8.16.2 Schedule Curve – Runtime Values 
If the checkbox Simulation is unchecked, the Schedule curve window switches to the current 
runtime data. 

 

The following information is provided: 

– Schedule 
Displays the currently selected schedule. 

– Left column: Potentiometer, Analog Current Input, Analog Voltage Input 
Displays the new calculated adjustment values for the potentiometer, current and voltage 
input. 

– Right column: Potentiometer, Analog Current Input, Analog Voltage Input 
Display of values supplied by the ignition controller for the potentiometer, current and 
voltage input. 

– Speed 
Display of the current speed 

– Timing Point 
Displays the current global ignition timing. 
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8.17  Coils 
The MICT has a database with technical information on MOTORTECH ignition coils. Open the 
database as follows: 

Tools -> Coils 

You have the option of storing and printing information on the ignition coils present in the 
database. For this purpose, the following functions are at your disposal in the toolbar in the 
Coils window. 

Symbol Function 

 

Stores the information on the selected ignition coil in a format that is 
appropriate for configuring the MIC3+ via fieldbus. 

 

Prints the selected coil data set. 

 

Prints the selected coil data set as PDF file. 

 

Opens the print preview. 

Coils 
– Device 

Select an ignition controller. 

– Coil 
Select an ignition coil. 

  

 

Select the correct ignition controller 

The ignition coil data depends on the ignition controller used. Always select 
the ignition controller for which you are using the coils in order to obtain 
the correct data. 
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8.17.1 General 

 

Details 
The following information is provided: 

– Name 
Coil name 

– Coil Type ID 
Used to clearly identify the ignition coil 

– Data Version 
Shows data version of the ignition coil selected in the database. The data version of the 
ignition coil configured in the ignition controller is displayed in the runtime data in the view 
Ignition (refer to Runtime Data – Ignition on page 114). The Automatic Online Update should 
be activated to ensure that the coil database always has the latest data sets. Additional 
information on the online update is provided in the section Online Update Settings on 
page 71. 
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– Illustration of the ignition coil 

– Information on the conditions under which a secondary diagnosis is possible using the 
displayed ignition coil. 

Coil Parameters 
The following information is provided: 

– Max. Breakdown Voltage [kV] 
Displays the permitted value range for the maximum breakdown voltage in kV. The 
maximum breakdown voltage is configured in the view Timing – Schedule A/B – Energy 
(refer to Timing – Schedule A/B – Energy on page 99). 

– Spark Intensity [mA] 
Displays the permitted value range for the spark intensity in mA. The spark intensity is 
configured in the view Timing – Schedule A/B – Energy (refer to Timing – Schedule A/B – 
Energy on page 99). 

– Secondary Voltage Estimation Calibration 
Displays the permitted value range for the secondary voltage estimation calibration. The 
calibration of the secondary voltage estimation takes place in the view Engine – Ignition 
Coils (refer to Engine – Ignition Coils on page 89) and in the runtime adjustments (refer to 
Runtime Adjustments – Secondary Voltage Calibration on page 142). 

– Secondary Short Sensitivity 
Displays the permitted value range for the calibration of the secondary short sensitivity. The 
calibration of the secondary short sensitivity takes place in the view Engine – Ignition Coils 
(refer to Engine – Ignition Coils on page 89) and in the runtime adjustments (refer to Runtime 
Adjustments – Secondary Short Calibration on page 143). 
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8.17.2 Min. Energy Limit Curve 

 

Min. Energy Limit Curve 
The curve provides information on the energy in mJ necessary to achieve a certain maximum 
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which 
a secondary diagnosis is possible. The corresponding energy settings can be found in the view 
Timing – Schedule A/B – Energy (refer to Timing – Schedule A/B – Energy on page 99). 

When printing the coil data set, the curve values are also provided as a list. 
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9.1  Start-up 
Before you start up the MIC3+ ignition controller, take note of the following:  

– Were the correct engine, ignition sequence, and output configuration selected? If you are 
unsure, contact MOTORTECH or the corresponding engine manufacturer. 

– Ensure that the firing order of the engine and/or the wiring of the output cable harness are 
carried out correctly. 

– Is the wiring of all pickups compliant with the drawings given in this operating manual? 

– Are the distances of the pickups to trigger discs, reluctor pins, etc. correctly set (see chapter 
Determine the Installation Location of the Pickup on page 34)? 

– Ensure that the data were transferred flawlessly to the controller. 

– Check whether the start/stop input is set to Firing Active, or whether it works according to 
the control requirements of the master control. 

– Check whether the input contact for parameter settings A/B (Schedule A/B) functions and 
ensure that the correct schedule (A or B) was selected for start-up. 

– Close the service screw and the service cover after completing the installation and 
configuration. 

– Ensure that no gas is present in the inlet and exhaust systems before you start the engine. 

– Ensure that the gas valve is closed. 

– Perform the normal engine start-up process while the gas valve is closed (start only). 

– Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing 
point set on the ignition controller coincides with the actual timing point on the crankshaft. 
If the ignition timing does not coincide exactly, change it (see chapter Runtime Data on page 
109) until the optimal setting is reached. If the ignition does not fire, read the instructions in 
section Troubleshooting on page 159. 

– Check all other cylinders for correct ignition. If they are not correct, stop the engine, and 
recheck wiring and ignition sequence for correctness. 

– Stop the starting process. If no problems occur, start the engine in accordance with the 
specifications of the engine manufacturer. 

 

9 Operation 
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9.2  Shutdown 
The ignition controller is shut down by disconnecting it from the power supply. 
 

9.3  Firmware Update 
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The 
program is provided on the storage device (USB flash drive or CD-ROM supplied). 

Install MOTORTECH Flash Tool 
Install the MOTORTECH Flash Tool as follows: 

1. Start the installation: 

– Via the menu: 
Start the file Start.exe on the storage device. Start the installation routine for the 
MOTORTECH Flash Tool via Software -> MOTORTECH Flash Tool -> Install MOTORTECH 
Flash Tool. 

– Directly from the storage device: 
Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage 
device in the subdirectory Installation and for example named as follows: MOTORTECH-
Flash-Tool-0.23.00000-setup.exe. 

2. Install the program. 
Follow the instructions of the installation routine. Note that the license agreement terms 
must be accepted before using the MOTORTECH Flash Tool. 

3. If the USB driver is not yet installed, also install it via the menu or directly from the storage 
device. 

– Via the menu: 
Software -> USB Drivers -> Install USB Drivers 

– Directly from the storage device: 
Start the exe file in subdirectory Drivers 
(e.g. CDM21226_Setup.exe). 

▸ The MOTORTECH Flash Tool is set up. You can now connect your computer to the ignition 
controller via the USB interface. 
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Menu Bar and Toolbar 
After launching the MOTORTECH Flash Tool, the following functions are available to you via the 
icons on the toolbar and the entries in the menu bar: 

Symbol Menu Function 

 

File -> Open Opens a firmware file. 

  File -> Quit Exits the program. 

  View -> Extended file information 
view 

Fades in / out additional information of the 
firmware file. 

  View -> Extended connection 
settings 

Fades in / out additional information and 
settings of the connection to the device. 

 

View -> Reload file Reloads the file information of the selected 
firmware file. 

 

Device -> Search devices Restarts the search for connected devices. 

 

Device -> Flash device Starts the update process or downgrade 
process. 

  Settings -> Language Opens the window Select Language in 
which you can change the interface 
language of the program. 

  Help -> Help Opens the online help function. 

  Help -> About MOTORTECH Flash 
Tool 

Opens detailed information on the 
program. 

  

Start Firmware Update 
  

 

Access control for firmware update 

If you have activated the access control for the ignition controller, you need 
the PIN for the level Master for the firmware update. For more information 
read the section Access Control for MIC3+ on page 76. 
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Backup the existing configuration 

Your device's configuration may be lost if the firmware update is not 
performed properly. Always backup the existing configuration via the MICT 
prior to performing an update. For more information read the section 
Working with Configurations on page 78. 

  
To start a firmware update, proceed as follows: 

1. If an MICT is connected with the ignition controller, disconnect this connection. 

2. Start the MOTORTECH Flash Tool via Start -> Programs -> MOTORTECH -> MOTORTECH Flash 
Tool -> x.x.x (e.g. 0.23.00000) -> MOTORTECH Flash Tool. 

▸ The MOTORTECH Flash Tool will now start. 

▸ The software automatically checks all ports for connected devices. 

3. In the Status section under Device, check if your device has been recognized properly. 

▸ If the MOTORTECH Flash Tool does not recognize a device that is connected to your 
computer via the USB interface, you can usually still carry out a firmware update. To do 
so, observe the instructions in the information windows of the MOTORTECH Flash Tool 
for the following steps. 

4. Select in area File using the Select button the desired update file. 

5. By reading the displayed file information, ensure that the update file is correct for your 
device. 

6. Start the update process using the Flash button or using the menu or toolbar. 

▸ The ignition controller is restarted automatically. 

▸ Now, a window opens informing you about the firmware version currently used on your 
ignition controller and also about the relevant update version. 

7. Confirm with Yes to proceed with the update process. 

▸ Now the update will start. 

▸ If the firmware update was successful, you will see a relevant message. 

8. After a successful firmware update, check all configuration data. 

  

 

Downgrade process 

The process for a downgrade is largely the same as the update process. You 
will only be informed that a new firmware has been installed on the device. 
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Help with connection problems 

If a correctly connected device is not found during the automatic search, 
this can, for example, be because too many communication interfaces are 
assigned and must be checked. In this case, an interface from the drop-
down list Port in the area Connection can be selected and thus specified. 

If the desired port is not yet displayed in the list or if the problem should 
continue, an adjustment of the time-outs for the connection helps. The 
time-out settings are displayed in the main view by the following entry in 
the menu bar: View -> Extended connection settings 

Enter the following settings: 

– Update Request Timeout 
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. 
An extension of the time-out can be an advantage, especially with 
connection problems that occur because the computer has many 
assigned ports. 

– Start Timeout 
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. A 
time-out change can be an advantage, especially with connection 
problems that occur because the communication between the computer 
and the device has been interrupted. 

  
 



 
 

Rev. 07/2021 157 

10.1  Possible Faults 
The MIC3+ ignition controllers include several safety functions that can shut down the engine in 
case of fault: 

– Overspeed protection 

– External shut-down contact (Start/Stop) 

– Misfire detection (primary) 

– Internal failure of the high voltage supply 

– Output Error Detection 

– Shut down in the case of a faulty pickup or faulty pickup signals. 

– Alarms 

– Faulty voltage supply 

– External EMI signals 
 

10.2  Causes of Faults 

10.2.1 Overspeed 
The engine speed has exceeded the set overspeed value. As of firmware version 1.11.00000, an 
operating error caused by overspeed is indicated on the device by the status LED flashing four 
times (4 times red/off 250 ms, 750 ms off). Refer to the section LED Functions on page 28. 

Potential Causes 
– Speed controller does not function properly 

– Fuel supply to engine is not optimal. 

– Faulty pickup signal 
 

10.2.2 Output Error Detection 
An internal failure of the high voltage supply or a defective output switch occurs. 

Potential Causes 
– Hardware fault on the MIC3+ 

– Defect in the wiring (short circuit or open circuit) 
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10.2.3 Misfire Detection (Primary) 
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime 
data. 

Potential Causes 
– Defect in the output wiring 

– Ignition coil defective 
 

10.2.4 Pickup Input Errors 
Faulty input signals from the pickups are detected. 

Potential Causes 
– Number of teeth on the flywheel does not match the set number. 

– Damage to or uneven running of trigger disc 

– Interference in the wiring of the pickup 

– Wiring of the pickup incorrect 

– Distance of the pickup incorrect 

– Dirt on the pickup 

Troubleshooting for Possible Causes 
You will find information on possible causes of a pickup input error in the windows Runtime Data 
– States (see Runtime Data – States on page 117) and Runtime Data – Message Log (see Runtime 
Data – Message Log on page 123). When analyzing the messages shown there, please note that 
the number of the pickup (e.g. PU2) only names the pickup at which the error or problem was 
identified. Hence, this does not mean that this particular pickup also caused the problem. For 
example, if the pickup PU1 is defect, it is entirely possible that, under certain circumstances, the 
problem may only be identified at pickup input PU2. 

For information on the numbers shown in the error messages (e.g. PU1=0x00001002), refer to 
the documentation on the pickup status bits on the storage device enclosed with the ignition 
controller. You can open the file via the menu: Documentation -> More information. 

For a more in-depth analysis of the problem, the pickup traces may support you. Refer to the 
section Pickup Trace on page 74. Compare the signals recorded there with the pickup settings in 
your configuration (see Engine – Pickups on page 91). 
 

10.2.5 Acknowledging Faults 
While the engine is shut down, you have the following options for acknowledging operating 
errors: 

– Use Error Acknowledge in the MICT 

– Acknowledgment of the error via CAN bus or RS485 

– By disconnecting the supply voltage 
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10.3  Troubleshooting 

10.3.1 Running a Self Test 
You can run the self test via the MICT to check the order of the wiring and the connection 
between the ignition controller outputs and the spark plugs. For this refer to section Self Test on 
page 72. 

  

 

Operational safety! 

If you carry out a self test, it is essential for the gas supply to be switched 
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons. 

  
 

10.3.2 Customer Service Information 
You can reach our customer service during business hours at the following phone and fax 
number, or by email: 

Phone:  +49 5141 93 99 0 

Fax:  +49 5141 93 99 99 

Email:  service@motortech.de 
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10.3.3 Returning Equipment for Repair / Inspection 
To return the device for repair and inspection, obtain a return form from your MOTORTECH 
contact person (see Customer Service Information on page 159). 

After you have completely filled out the return form and returned it to MOTORTECH, MOTORTECH 
will send you back the return form and a delivery note with RMA number specified. Enclose the 
return form with your device and attach the delivery note to the packaging so that it is clearly 
visible from the outside. This guarantees a fast and smooth processing of your repair order. 

Send the device with delivery note and return form to one of the two addresses below or to the 
nearest MOTORTECH representative: 

  
MOTORTECH GmbH 
Hogrevestr. 21–23 
29223 Celle 

Germany 

Phone:  +49 5141 93 99 0 
Fax:  +49 5141 93 99 98 

www.motortech.de 
motortech@motortech.de 

MOTORTECH Americas, LLC 
1400 Dealers Avenue, Suite A 
New Orleans, LA 70123 

USA 

Phone:  +1 504 355 4212 
Fax:  +1 504 355 4217 

www.motortechamericas.com 
info@motortechamericas.com 

  
 

10.3.4 Instructions for Packaging the Equipment 
For return shipment, equipment should be packaged as follows: 

– Use packaging material that does not damage the equipment surfaces. 

– Wrap the equipment with sturdy materials and stabilize it inside the packaging. 

– Use sturdy adhesive film to seal the packaging. 
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11.1  Maintenance Instructions 
Please follow the following maintenance instructions: 

– Do not use caustic liquids or steam cleaners for cleaning the device. 

– Clean the passive pickups at regular intervals. 

– Check the ignition wires at regular intervals. 

– Replace the pickups at regular intervals if operating them under elevated temperature 
conditions (> +90 °C / > +194 °F). 

– Regularly inspect all wires of the ignition system for damage and replace the wires as 
needed. 

– Check all plug-in connections for proper condition. 

– Service the spark plugs as per the instructions of the spark plug and engine manufacturers. 
 

11.2  Spare Parts and Accessories 
For spare parts and accessories for MIC3+ ignition systems, please refer to our current product 
guide, which is available for download on the Internet at www.motortech.de. 

 

11 Maintenance 



 
 

162 Rev. 07/2021 

A 
Abbreviation ................................................... 8 
Access Control 

Activate .................................................... 76 
Device ...................................................... 76 

Advanced service 
Access level .............................................. 66 

Alarm 
Acknowledge ........................................... 123 
Detail ......................................................128 
Function ................................................... 60 
Overview .................................................128 

Alarm configuration 
View ........................................................ 101 

Arrangement number .....................................21 
ASO 

Example.................................................... 61 
Function ................................................... 61 
Setting .................................................... 103 
Wiring ...................................................... 44 

Auxiliary synchronization output 
Example.................................................... 61 
Function ................................................... 61 
Setting .................................................... 103 
Wiring ...................................................... 44 

B 
Base timing 

Setting ..................................................... 97 

C 
CAN bus 

Interface ................................................... 25 
Setting ................................................... 106 
Wiring ...................................................... 47 

Coil type 
Setting ..................................................... 83 

Coils ........................................................... 148 
Configuration 

Download ................................................. 78 
Open ........................................................ 78 
Upload ..................................................... 78 

Current input 
Current value ........................................... 113 
Function ................................................... 57 
Setting ................................................ 95, 97 

Customer 
Access level .............................................. 66 

Cylinder name ............................................... 86 

D 
Declaration of conformity ............................... 18 
Device 

Dimension ................................................ 26 
Disposal ................................................... 16 
Electrical data ........................................... 21 
Installation ............................................... 31 
Mechanical data ........................................ 19 
Return..................................................... 160 
Select type ................................................ 79 
Start-up ................................................... 152 
Switching off ............................................ 153 

Downgrade 
Process sequence ..................................... 153 

E 
Electrostatics ................................................ 12 
Energy 

Overview .................................................. 115 
Setting ............................................... 99, 141 

Energy limit 
Start phase ............................................... 99 

Engine 
Define ....................................................... 87 
Selection .................................................. 83 
Setting ...................................................... 83 

Engine database ..................................... 83, 87 

F 
Failure 

Acknowledge...................................... 68, 158 
Logging ................................................... 137 
Overspeed ............................................... 157 
Overview ................................................. 129 
Pickups ................................................... 158 
View ........................................................123 

Firing angle 
Calculation ................................................ 59 

Firmware 
Downgrade .............................................. 153 
Update ..................................................... 153 

G 
General purpose output 

Function .................................................... 61 
Wiring ....................................................... 44 

Go/NoGo output 
Function .................................................... 55 
Wiring ....................................................... 44 

12 Index 



12 Index 
 

Rev. 07/2021 163 

GPO 
Function .................................................... 61 
Wiring ....................................................... 44 

H 
Hall effect sensor 

Supply voltage .......................................... 91 

I 
Ignition coils 

Setting ...................................................... 89 
Wiring ....................................................... 50 

Ignition controller 
Dimension ................................................. 26 
Disposal .................................................... 16 
Electrical data ........................................... 21 
Installation ................................................ 31 
Mechanical data ........................................ 19 
Return ..................................................... 160 
Select type ................................................ 79 
Start-up .................................................. 152 
Switching off ........................................... 153 

Ignition Timing Adjustment 
Maximum ................................................ 100 

Index 
Setting ...................................................... 91 

Information 
To device ................................................. 136 

Input 
Electrical data ........................................... 21 

Installation ................................................... 31 
MICT ......................................................... 65 

L 
Log file 

Create ......................................................137 

M 
Menu 

MICT .........................................................68 
MIC3+ 

Dimension ................................................. 26 
Disposal .................................................... 16 
Electrical data ........................................... 21 
Installation ................................................ 31 
Mechanical data ........................................ 19 
Return ..................................................... 160 
Select type ................................................ 79 
Start-up .................................................. 152 
Switching off ........................................... 153 

MICT 
Access level .............................................. 66 
Design ...................................................... 67 
Installation ................................................ 65 
Menu overview ......................................... 68 
Operation .................................................. 67 
Symbol overview ....................................... 68 
System requirements ................................. 65 
Update ...................................................... 71 

Misfire rate 
Causes .................................................... 158 

Misfiring 
Overview .................................................. 115 

MOTORTECH 
Address ................................................... 160 

MOTORTECH Integrated Configuration Tool 
Access level .............................................. 66 
Design ...................................................... 67 
Installation ................................................ 65 
Menu overview ......................................... 68 
Operation .................................................. 67 
Symbol overview ....................................... 68 
System requirements ................................. 65 
Update ...................................................... 71 

N 
Nominal speed 

Setting ...................................................... 91 

O 
Operating data 

Overview ................................................. 110 
Printing ................................................... 109 

Operating hours 
Engine ..................................................... 110 
Set ........................................................... 68 
Spark plug ............................................... 110 

Operating level 
Login ......................................................... 77 

Output 
Electrical data ............................................ 21 

Overspeed 
Exceeded ................................................. 157 
Setting ...................................................... 91 

P 
Parameter settings (schedule) 

Function ................................................... 60 
Representation ........................................ 147 
Setting ................................................ 97, 99 
Simulation ............................................... 145 



12 Index 
 

164 Rev. 07/2021 

Part number ...................................................21 
Pickup input 

Setting ......................................................91 
Pickup sensitivity 

Function ................................................... 55 
Setting ......................................................91 

Pickups 
Calculate frequency ....................................21 
Check ....................................................... 55 
Record ...................................................... 74 
Setting ......................................................91 
Supply voltage ...........................................91 
Wiring ...................................................... 39 

PIN 
Change ......................................................77 
Reset .........................................................77 

Potentiometer 
Current value ........................................... 113 
Setting ..................................................... 97 

Power supply 
Analog inputs ............................................ 95 
Wiring ...................................................... 37 

PowerView3 
Wiring ...................................................... 45 

Pre-trigger voltage 
Setting ......................................................91 

Printing 
Operating data ......................................... 109 

R 
Read only 

Access level .............................................. 66 
Regulations 

Overview .................................................. 18 
Repair ........................................................ 160 
Required current ............................................21 
Reset 

Setting .................................................... 139 
Return shipment ......................................... 160 
RS485 Interface 

Wiring ...................................................... 49 

S 
Safety device 

Wiring ...................................................... 41 
Safety function 

Overview ................................................. 157 
Safety instructions .................................... 11, 15 
Secondary voltage 

Secondary short detection ........................ 143 
Secondary voltage estimation ................... 142 

Security speed 
Setting ......................................................91 

Self Test ................................................ 72, 159 
Serial number 

Device ...................................................... 21 
Service 

Access level .............................................. 66 
Service contact 

Setting .................................................... 108 
Shut off ....................................................... 153 
Software 

Access level .............................................. 66 
Design ...................................................... 67 
Installation ............................................... 65 
Menu overview .......................................... 68 
Operation ................................................. 67 
Symbol overview ....................................... 68 
System requirements ................................. 65 
Update .......................................................71 

Spark duration 
Overview .................................................. 115 
Setting ...................................................... 99 

Spark plug hours 
Set ........................................................... 68 

Speed 
Current value ........................................... 110 
Max. value ............................................... 110 

Speed curve 
Current value ........................................... 113 
Function .................................................... 59 
Setting ...................................................... 97 

Speed limit 
Start phase ............................................... 99 

Start phase 
Energy limit ............................................... 99 
Speed limit ............................................... 99 

Starter speed 
Setting ...................................................... 91 

Start-up ....................................................... 152 
System state 

Overview .................................................. 110 

T 
Temperature 

Board ...................................................... 135 
Timing 

Base ................................................. 110, 113 
Global ............................................... 110, 113 
Limits ....................................................... 97 
Overview .................................................. 113 
Setting .................................................... 140 

Timing correction 
Current value ........................................... 113 
Function .................................................... 59 



12 Index 
 

Rev. 07/2021 165 

Timing setup 
Wiring ....................................................... 41 

U 
Update 

Process sequence .................................... 153 
USB 

Connection ................................................ 25 

V 
Voltage input 

Current value ............................................ 113 
Function .................................................... 57 
Setting ................................................ 95, 97 

W 
Wiring 

Auxiliary synchronization output ................ 44 
CAN bus .................................................... 47 
Direct .................................................. 52, 83 
General purpose output ............................. 44 
Go/NoGo output ........................................ 44 
Pickups ..................................................... 39 
Power supply ............................................. 37 
PowerView3 .............................................. 45 
Safety device ............................................. 41 
Timing setup ............................................. 41 

 



 

 

 

 


	1  General Information
	1.1  What Is the Purpose of this Operating Manual?
	1.2  Who Is this Operating Manual Targeted to?
	1.3  Which Symbols Are Used in the Operating Manual?
	1.4  Which Abbreviations/Acronyms Are Used in the Operating Manual?

	2  Safety Instructions
	2.1  General Safety Instructions
	2.2  Electrostatic Discharge Hazards
	2.3  Information on Electric Isolation
	2.4  Special Safety Instructions for the Device
	2.5  Proper Disposal

	3  Intended Use
	3.1  Functional Description
	3.2  Applications

	4  Product Description
	4.1  Technical Data
	4.1.1 Certifications
	4.1.2 Mechanical Data
	4.1.3 Warning Notices on the Device
	4.1.4 Product Identification – Labeling on the Device
	4.1.5 Electrical Data
	4.1.6 Interfaces
	4.1.7 Requirements for External Equipment
	4.1.8 Overview Drawings
	4.1.9 LED Functions


	5  Installation Instructions
	5.1  Unpacking
	5.2  Installation of the Ignition Controller
	5.2.1 Installation of the Vibration Dampers
	5.2.2 Installation of the Ground Strap

	5.3  Determine the Installation Location of the Pickup

	6  Wiring of the Device
	6.1  Input and Output Wiring on the Controller
	6.1.1 Input Wiring
	6.1.2 Input Wiring – Power Supply
	6.1.3 Input Wiring – Pickups
	6.1.4 Input Wiring – Timing and Safety Devices
	6.1.5 Output Wiring – Binary Outputs (Go/NoGo, GPO, ASO)
	6.1.6 Wiring – PowerView3
	6.1.7 Output Wiring – CAN Bus Interface
	6.1.8 Output Wiring – RS485 Interface

	6.2  Ignition Coil Wiring
	6.3  Straight Order Wiring of the Ignition Outputs

	7  Functions
	7.1  Pickup Sensitivity
	7.2  Monitoring of Pickup Signals
	7.3  Go/NoGo
	7.4  Ignition Timing Adjustment
	7.4.1 Analog Inputs
	7.4.2 Cylinder-to-Cylinder Alignment
	7.4.3 Speed Curve
	7.4.4 Ignition Timing Correction

	7.5  Firing Angle
	7.6  HV-Power Supply Error Monitoring
	7.7  Output Monitoring
	7.8  Schedules A/B
	7.9  Alarms
	7.10  GPO: General Purpose Output
	7.11  ASO: Auxiliary Synchronization Output
	7.12  Ignition Energy
	7.13  Access Control

	8  Settings via the MICT
	8.1  MICT System Requirements
	8.2  MICT Installation
	8.3  Access Levels in the MICT
	8.4  Configuration Pages (Overview)
	8.5  Menu Bar and Toolbar
	8.6  Online Update Settings
	8.7  Self Test
	8.8  Pickup Trace
	8.9  Access Control for MIC3+
	8.9.1 Enable/Disable Access Control
	8.9.2 Login/Logout
	8.9.3 Changing the PIN
	8.9.4 Reset all PINs

	8.10  Working with Configurations
	8.10.1 Create, Open, Save
	8.10.2 Upload, Download
	8.10.3 Compatibility Information

	8.11  Configuration
	8.11.1 Engine – Parameters
	8.11.2 Engine – Cylinder Names
	8.11.3 Engine – Ignition Outputs
	8.11.4 Engine – Ignition Coils
	8.11.5 Engine – Pickups
	8.11.6 Timing – Analog Inputs
	8.11.7 Timing – Schedule A/B – General
	8.11.8 Timing – Schedule A/B – Energy
	8.11.9 Timing – Miscellaneous
	8.11.10 Inputs/Outputs – Alarms
	8.11.11 Inputs/Outputs – ASO1 (Auxiliary Synchronization Output)
	8.11.12 Inputs/Outputs – Inputs
	8.11.13 Miscellaneous – Communication
	8.11.14 Miscellaneous – Information

	8.12  Runtime Data
	8.12.1 Runtime Data – Overview
	8.12.2 Runtime Data – Timing
	8.12.3 Runtime Data – Ignition
	8.12.4 Runtime Data – Bank A
	8.12.5 Runtime Data – States
	8.12.6 Runtime Data – Message Log
	8.12.6.1 Information
	8.12.6.2 Warnings
	8.12.6.3 Alarms
	8.12.6.4 Failure

	8.12.7 Runtime Data – Diagnostics
	8.12.8 Runtime Data – Temperatures
	8.12.9 Runtime Data – Information

	8.13  Log
	8.14  Runtime Adjustments
	8.14.1 Runtime Adjustments – Reset
	8.14.2 Runtime Adjustments – Timing
	8.14.3 Runtime Adjustments – Energy
	8.14.4 Runtime Adjustments – Secondary Voltage Calibration
	8.14.5 Runtime Adjustments – Secondary Short Calibration

	8.15  Cylinder Individual Offsets
	8.16  Schedule Curve
	8.16.1 Schedule Curve – Simulation
	8.16.2 Schedule Curve – Runtime Values

	8.17  Coils
	8.17.1 General
	8.17.2 Min. Energy Limit Curve


	9  Operation
	9.1  Start-up
	9.2  Shutdown
	9.3  Firmware Update

	10  Errors
	10.1  Possible Faults
	10.2  Causes of Faults
	10.2.1 Overspeed
	10.2.2 Output Error Detection
	10.2.3 Misfire Detection (Primary)
	10.2.4 Pickup Input Errors
	10.2.5 Acknowledging Faults

	10.3  Troubleshooting
	10.3.1 Running a Self Test
	10.3.2 Customer Service Information
	10.3.3 Returning Equipment for Repair / Inspection
	10.3.4 Instructions for Packaging the Equipment


	11  Maintenance
	11.1  Maintenance Instructions
	11.2  Spare Parts and Accessories

	12  Index

